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Nonlinear Finite Element Modeling of a Field-Cast Connection Composed of 

High-Early Strength Concrete with Polypropylene Fibers and Headed Bars 

for Bridge Prefabricated Elements 

 

Thesis Abstract – Idaho State University (2019) 

 

An alternative mix design using polypropylene fiber-reinforced High Early Strength (HES) 

concrete was proposed by the Idaho Transportation Department (ITD) for connection between 

precast bridge girders in Accelerated Bridge Construction (ABC). In this thesis, finite element 

models of the pullout behavior of headed reinforcing bars in the closure pour and bending tests 

of beams representing a 1-foot strip of the bridge deck were developed. The “smeared crack” 

along with the William-Warnke failure criteria was used for concrete, while Cohesive Zone 

Modeling (CZM) showed good results in representing the interface between the closure pour 

and precast concrete. Steel-concrete bond-slip behavior was observed to be one of the biggest 

factors affecting the results. A scheme to simulate this behavior using zero-length nonlinear 

spring elements was designed. The finite element models were able to produce results similar 

to the experimental findings, especially in the linear region.

Key Words: Bridge, deck, connections, precast elements, accelerated bridge construction, 

ABC, finite element modeling, nonlinear. 
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Chapter 1: Introduction 

1.1 Preamble 

Accelerated Bridge Construction (ABC), a relatively new method in the U.S.A, has been 

undergoing an accelerated advancement in terms of implementation. This advancement has 

been facilitated by the various research projects initiated by the State Departments of 

Transportation (DOTs). The DOTs have developed their own standards and guidelines for 

ABC. One particular area of interest in ABC is the connection design between the precast 

bridge elements. Currently, the most popular option for the closure pour material in the 

connection between two neighboring precast deck elements is Ultra High-Performance 

Concrete (UHPC). Although UHPC is an excellent material in terms of strength (compressive 

strength reaching up to 30 ksi), it is a proprietary material with some other disadvantages like 

high installation cost, rigorous quality control requirements, fast setting time and being more 

labor-intensive (Ebrahimpour et al. 2018). As an alternative, the Idaho Transportation 

Department is proposing the use of High Early Strength (HES) concrete reinforced with 

polypropylene fibers as the closure pour material between the girders. This study is a part of 

the project to investigate the proposed closure pour material, which specifically focuses on the 

development of Finite Element models based on experimental studies. 

1.2 Problem Statement 

There have been several experimental tests showing that precast bridge deck panels or girders 

may be effectively connected by placing UHPC in 6 inches wide closure pours between the 

precast elements. UHPC allows full strength development of #6 bars extended from precast 

elements into the narrow 6 inches closure pours. Casanova 2018 tested polypropylene fiber-

reinforced HES in 10 inches closure pour between precast girders. Casanova 2018 used #5 

headed rebars protruding out from the precast elements. A typical closure pour section between 
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two girders, and the reinforcing details in one girder proposed by the ITD are shown in Figure 

1.1. 

 

Figure 1.1:  Example of closure pour between deck bulb-T girders with reinforcing details. 

 

The purpose of this thesis is to develop finite element models based on the experimental data 

obtained using the optimum HES concrete mix developed by Casanova 2018. Finite element 

models will be developed to study the behavior of the proposed design to study its performance 

in element level and assembly level.  

1.3 Objectives and Deliverables 

The objectives and deliverable for this study are: 
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• Study the pullout behavior of #5 headed rebars embedded in the proposed concrete 

connection design. A finite element model will be developed based on the pullout tests 

and validated using the results obtained from the experiments. 

• Investigate the cracking moment and the ultimate strength of a beam representing a 1-

foot strip of the bridge deck that includes the proposed closure pour connection details. 

Finite elements models will be developed for the beams and validated using the results 

of three-point and four-point bending test results. 

1.4 Thesis Outline 

This thesis is divided into 6 chapters. 

• Chapter 1 gives a brief outline of the problem statement and the objectives. 

• Chapter 2 contains the literature review of experimental studies on concrete 

connections and bond-slip behavior of rebars in concrete 

• Chapter 3 contains the literature review and background information on finite element 

modeling of concrete and bond-slip behavior of rebars in concrete. 

• Chapter 4 describes the methodology used in developing the models for the pullout 

test, and the beam bending tests. 

• Chapter 5 discusses the results obtained from the models developed in chapter 4. 

• Chapter 6 presents the summary, conclusion and recommendations based on the results 

discussed in chapter 5. 

Furthermore, this thesis contains 4 appendices.  

• Appendix A describes a verification scheme for the concrete model used in the finite 

element models. 

• Appendix B contains the verification of the techniques used for modeling the concrete-

concrete bonds and the bond-slip phenomenon between steel and concrete.  



4 

 

• Appendix C describes the procedure for preparing the 3D model of the flexural beam 

tests to be used in the FE modeling using Onshape- a cloud-based 3D CAD program. 

• Appendix D contains detailed step-by-step procedures for the development of the finite 

element models for the 3-point and 4-point flexural beam tests. 
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Chapter 2: Experimental Background 

 

2.1 Introduction 

Reinforced concrete construction is mostly based on the assumption that steel and concrete are 

perfectly bonded together. However, the issue with the steel-concrete bond has been identified 

and has been extensively researched since the nineteenth century. As a result, deformed, bent, 

twisted and headed bars were introduced for better bond strength. These geometric variations 

resulted in complicated bond analyses. With the introduction of newer construction materials 

like FRP bars, fiber reinforced concrete and alkali activated concrete variations in the bond 

strength were observed. Many other parameters like mix proportion, bar spacing, casting 

direction, concrete cover and concrete confinement also play significant roles in bond strength. 

Much research over the variation of bond strength with the change of these parameters has been 

conducted over the years. In this chapter, prior studies on steel-concrete bond mechanism will 

be explored. Studies on cast-in-place concrete connections will also be reviewed. A suitable 

cast-in-place concrete connection method that can draw a balance between serviceability and 

cost-efficiency, is a key component to achieve the maximum benefit of the Accelerated Bridge 

Construction (ABC) method. The advancement of ABC implementation in the US has been 

experiencing a significant acceleration in recent years. Finally, this chapter will briefly describe 

the experimental procedures performed by Casanova 2018. Most of this study is based on these 

experiments and the obtained results. 

2.2 Literature Review 

In this study, two types of bond play important roles. Firstly, the bond between steel rebars and 

concrete. The second type of bond is the interface bond between the closure pour and the 
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precast concrete. Numerous studies have been carried out to determine the nature and 

importance of these two types of bonds in reinforced concrete structures. 

2.2.1 Steel- Concrete Bond Mechanism 

A simple definition of bond is the transfer of stress between steel and concrete. This transfer 

has three components (Lutz and Gergely 1967): 

1. Chemical adhesion, 

2. Friction, 

3. Mechanical interlocking between concrete and steel. 

The bond in plain bars is mainly dependent on the first two components. Deformed bars 

primarily depend on mechanical interlocking. However, the effect of the other two factors is 

not absent in deformed bars. 

2.2.1.1 Bond in Plain Bars 

Although many concrete structures were constructed with plain reinforcing bars before the 

1970s (Hertanto 2005), the majority of the literature deal with deformed bars. The data on the 

anchorage and pullout behavior of plain bars are not adequate. 

Plain bars do not have ribs or any surface irregularity. Therefore, bond force cannot be 

transferred through mechanical interlocking. Abrams 1913, found that chemical adhesion and 

friction do not act simultaneously on a given point. The adhesive resistance has to be overcome 

before the sliding resistance becomes effective. According to Abrams 1913, the irregularities 

on the bar surface, section and alignment, and the wedging action of small particles that break 

free from the concrete upon slip. 

Feldman and Bartlett 2005, studied a total of 252 pullout specimens with plain reinforcing bars 

and investigated various parameters like concrete compressive strength, bar size, bar shape, 
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concrete cover and bar surface roughness. The coefficient of variation of maximum average 

bond stress normalized by the square root of the concrete compressive strength decreases with 

increasing embedment length and bar roughness but has no correlation with concrete cover or 

bar size. 

Xing et al. 2015, studied the comparative bond behavior in pullout specimens with plain and 

deformed bars. Adhesive stress was found to be about 2 to 5% of the total bond stress in 

deformed bars, while 11% of the bond stress in plain bars were attributed to adhesion. Figure 

2.1 shows the components of bond strengths in plain and deformed bars where x represents the 

percentage contribution due to adhesion force. 

 

Figure 2.1: Components of bond strength in (a) deformed bar and (b) plain bar (Xing et al. 

2015). 

2.2.1.2 Bond in Deformed Bars 

In comparison to plain bars, the literature related to the study of anchorage and pullout behavior 

of deformed bars is abounding. Many studies have been conducted to investigate the bond 

response mechanism of deformed bars in concrete in the scales of the structural elements, the 

reinforcement, and the reinforcement ribs. In addition to the bar geometry, other parameters 

like the concrete constitution, loading pattern, embedment length, concrete confinement etc. 
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were also thoroughly studied. Mathey and Watstein 1961, conducted experiments on 18 beams 

and 18 pullout specimens with deformed reinforcing bars and reported that the bond strength, 

expressed as force per unit bar surface area, decreases with the increase of embedment length. 

The bond strength also decreases with the increase of bar diameter. Bond stress was defined by 

Equation (2.1): 

Where, 

u = bond stress, 

𝑓𝑠 = bar stress computed by straight line theory, 

𝐴𝑠 = cross-sectional area of the bar, 

𝛴0 = bar perimeter, 

L = embedment length. 

The maximum bond stress, 𝑢𝑚, corresponding to the maximum bar stress calculated, indicates 

a nearly complete state of collapse i.e., no bond between steel and concrete. The critical bond 

stress, 𝑢𝑐, corresponds to the condition that indicates an impending bond failure. A 

measurement of both the slips at the loaded and the free end showed that a loaded-end slip 

alone cannot indicate the impending bond failure in a beam. Therefore, Mathey and Watstein 

1961, used two criteria to define critical bond stress: a loaded-end slip of 0.01 inch and a free-

end slip of 0.002 inch, whichever occurs first. A linear relationship between the critical bond 

stresses and the ratio of the bar diameter to length of embedment was observed. Equation (2.1) 

can be rearranged as 𝑢 = (𝑓𝑠𝜋𝐷
2)/(4𝜋𝐷𝐿). Thus, in Figure 2.2, 𝑢𝑐 (𝑓𝑠)𝑐⁄  is equal to 𝐷/4𝐿, 

where D= bar diameter and L= embedment length. Also, the adjusted values of 𝑢𝑐 is obtained 

 
𝑢 =

𝑓𝑠𝐴𝑠
𝛴0𝐿

 
(2.1) 
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by multiplying the observed values by the factor 𝑓𝑐′̅ 𝑓𝑐
′⁄  where 𝑓𝑐′̅ is the average value obtained 

for each group of specimens containing bars of a given size. 

 

Figure 2.2: Adjusted critical bond stress, 𝒖𝒄 vs the ratio 𝒖𝒄 (𝒇𝒔)𝒄⁄  for beams, where (𝒇𝒔)𝒄 is the 

stress in the reinforcing bar (Mathey and Watstein 1961) 

 

Lutz and Gergely 1967, reported that, if the rib face angle of the reinforcing bar is greater than 

40°, the slip occurs almost entirely due to crushing of the concrete in front of the ribs. On the 

other hand, when the rib face angle is less than 30°, the slip is due primarily to the relative 

movement between concrete and steel along the face of the rib, where the rib pushes the 

concrete away from the bar (wedging action). After the formation of surface flexural cracks, a 

separation of bar and concrete occurs near the vicinity of a crack. While this separation results 

in a complete loss of bond in the case of plain bars (Mathey and Watstein 1961), the ribs in a 

deformed bar prevent much of the crack opening near the bar. Thus, a large variation in crack 

width from bar to surface is observed in deformed bars (Lutz and Gergely 1967) as shown in 

Figure 2.3. 
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Figure 2.3: Section through reinforcing bar and concrete showing separation that occurs near a 

primary crack (Lutz and Gergely 1967) 

 

At a high level of stress, internal cracks around the deformed bar form besides external flexural 

cracks. These internal cracks also influence and define the bond mechanism between concrete 

and bar. Goto 1971, studied the internal cracks by injecting ink into the tension specimens in 

axially-loaded tests. The internal cracks form near the lugs and approach the nearest primary 

crack by compressive forces transferred by the bar lugs, at an angle of about 60° with the bar 

axis. This inclination of the internal cracks tightens the concrete around the bar and thus 

increases the friction between the concrete and the deformed bar (Figure 2.4). 

 

Figure 2.4: Internal cracks around the reinforcing bar embedded in concrete (Goto 1971) 
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For the constant moment region between two flexural cracks in a beam, the average unit bond 

stress (in units of shear force per unit interface area) is given by Equations (2.2) and (2.3). 

 

Or, 

 

Where, 

𝑢 = average bond stress at a location, 

𝑑𝑇 = change in bar tension over the length of 𝑑𝑥, 

𝛴0 = bar perimeter, 

𝐴𝑠 = cross-sectional area of the bar, 

𝑑𝑓𝑠 = change in steel tensile stress over the length of 𝑑𝑥 

Equation (2.3) can be expressed as: 

 

Where, 𝐸𝑠= elastic modulus of steel and 𝑑𝜀𝑠= steel strain corresponding to a change of bar 

stress equal to 𝑑𝑓𝑠. Thus, bond stress at a particular point for a given load is proportional to the 

 
𝑢 =

𝑑𝑇

𝛴0𝑑𝑥
 

(2.2) 

 
𝑢 =

𝐴𝑠𝑑𝑓𝑠
𝛴0𝑑𝑥

 
(2.3) 

 
𝑢 =

𝐴𝑠𝐸𝑠
𝛴0

𝑑𝜀𝑠
𝑑𝑥

 
(2.4) 
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slope of the steel strain curve at that point. Nilson 1972, from there, proposed a displacement 

function for steel and concrete with respect to a reference plane of known slip. 

 

Where,  

𝑆𝑎 = known slip at point a, 

𝑆𝑏 = desired slip at point b, 

𝜀𝑠 = steel strain, 

𝜀𝑐 = concrete strain. 

From the works of Lutz and Gergely 1967 and Goto 1971, Tepfers 1979, showed that the radial 

components of the bond forces are balanced against rings of tensile stress in the concrete. 

According to the model proposed by Tepfers, the concrete surrounding a single reinforcing bar 

is characterized as a thick-walled cylinder subjected to internal pressure and shear. The internal 

shear and pressure correspond to the bond and radial stresses developed at the bar-concrete 

interface respectively. Thus, the transfer of radial force at the bond determines the tensile hoop 

stress in the concrete surrounding the bar. The critical load is hereby controlled by the capacity 

of the concrete to carry the hoop stress. 

To sum up, the ribs of the bar can split the concrete without crushing it when the resistance of 

the surrounding concrete is moderate. For example, in the case of ordinary concrete cover. This 

statement is also true for high-strength concrete, as confirmed by Rao et al. 2007. They tested 

forty pullout specimens for bond strength and its variation. It was observed that ideal pullout 

failure occurred in all the specimens with confinement (Figure 2.5a), while the unconfined 

 
𝑆𝑏 = 𝑆𝑎 +∫ 𝜀𝑠𝑑𝑥

𝑏

𝑎

−∫ 𝜀𝑐𝑑𝑥
𝑏

𝑎

 
(2.5) 
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specimens failed by longitudinal splitting of concrete (Figure 2.5b). In the case of unconfined 

specimens, the failure was caused by the formation of a concrete cone from the concrete block 

due to bond forces acting on the concrete in front of rebar lugs. Splitting cracks developed in 

confined specimens, but their growth was impeded by the confinement. The maximum bond 

strength of unconfined concrete was found to be between 50% and 60% of that with 

confinement. 

 

Figure 2.5: (a) Pullout failure and (b) Splitting failure (Rao et al. 2017) 

 

2.2.1.3 Bond in Headed Bars  

In reinforced concrete construction, a sufficient amount of bar surface area is needed to be 

exposed to the concrete to develop anchorage so that the bar can reach its yield stress. For this 

purpose, bends and hooks are used in plain and deformed straight bars to provide the required 

development length. This development length can become quite long, especially in concrete 

with low confinement. This problem becomes more severe particularly in the design of 

structures for blast loads and in areas of high seismic activities. Due to high levels of steel 
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congestion, the reinforcement detailing can become very complicated in these cases. The use 

of headed bars can substantially reduce this congestion and make the construction procedure 

easier. 

Headed reinforcing bar is a relatively new technology. Recent advances in welding have made 

it cost-efficient to attach steel plates (heads) to the ends of smooth or deformed bars. This head 

on the bar provides a separate load path, as shown in Figure 2.6. According to Dahl 1995 (as 

cited in Wright and McCabe 1997), a minimum of 75% of the load is taken by the head, and 

the remaining 25% load is carried by the conventional bond strength. 

 

Figure 2.6: Bond force transfer in hooked and headed bars (Courtesy: Headed Reinforcement 

Corp., CA) 

 

A relatively small amount of literature on the bond behavior of headed bars is available. Most 

of the early research on headed bars were conducted in Norway, sponsored by Metalock 

Industries, the producer of headed bars in Norway, or by various oil companies and contractors. 



15 

 

Eventually, much of the early works are proprietary and not published. Later, research works 

have been carried out in many countries to investigate the effectiveness of headed bars in 

various types of structures and structural elements. It has been found that in many cases, headed 

bars can provide better confinement of joints, anchor larger bars, and show a better response to 

cyclic loading. Figure 2.7 indicates the comparison between the bond stress-strain 

characteristics in headed bars and hooked bars. 

 

Figure 2.7: Stress-strain behavior of anchorage by headed bar and bent bar under repeated 

loading. (Fynboe and Thorenfeldt 1986) 

 

Headed bars also show better bond-slip response than hooked and bent bars under monotonic 

loading conditions. In hooked bar, a radial force of T/R per unit length is exerted on the 

concrete inside the bend, where T is the tensile force developed in the hook and R is the inner 

radius of the bend. Thus, the average bearing stress on the concrete is T/R𝑑𝑏, where 𝑑𝑏 is the 
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diameter of the bar. According to the ACI 318 Code (ACI Committee 318 2008), 𝑅 ≥ 2𝑑𝑏 for 

𝑑𝑏 ≤
5
8⁄  in. (16 mm). Using the value of R = 2𝑑𝑏, the average bearing stress on concrete 

becomes (𝜎𝑠𝜋𝑑𝑏
2)/(4)(2𝑑𝑏

2) = 0.4𝜎𝑠; where 𝜎𝑠 is the stress developed in the hook. When 𝜎𝑠 

approaches the yield strength 𝑓𝑦 of the bar, the bearing stress can damage (split or crush) the 

concrete inside the bend. This results in bond slip, preventing the hook to develop the stress 𝑓𝑦 

in the bar. Leonhardt and Walther 1965 (as cited in Ghali and Youakim 2005) measured the 

slip at the bends of 90-, 135- and 180-degrees of hooks, with heavier bars lodged inside the 

bends. Eligehausen 1996, carried out similar experiments with headed studs. The comparison 

between the results obtained by Leonhardt & Walther 1965 and Eligenhausen 1996 is given in 

Table 1.1.  

Table 2.1: Comparison of slips of hooked bars (Leonhardt & Walther 1965) and headed studs 

(Eligenhausen 1996) anchored in 3.6 ksi concrete. 

Stress (ksi) Slip in Hooked Bars (in) Slip in Headed Studs (in) 

58 0.004 to 0.01 0.0005 to 0.001 

72.5 0.008 to 0.035 0.0009 to 0.002 

 

Another advantage of the headed bar is the risk of spalling of concrete cover by straightening 

bend can be eliminated (Figure 2.8). It can also be seen from Figure 2.8 that, headed bars can 

still develop the full tensile strength if the cover is lost. 
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Figure 2.8: Spalling of concrete cover by straightening bend 

 

2.2.1.4 Failure Modes in Headed Bars 

The headed bar can fail by yielding or fracturing if the total yield stress or ultimate stress is 

allowed to develop. Other than that, two failure modes govern the design of concrete members 

using headed bars- pullout cone failure, and side blowout failure (Figure 2.9). Pullout cone 

failure is more likely when the ratio of embedment depth to the side cover (distance to the 

nearest edge of concrete) is small. When this ratio is large, side blowout failure is more 

probable. The size of the failure cone depends on the embedment length of the headed bar. 

DeVries 1996, conducted pullout tests on 140 samples and investigated the effect of variables 

like embedment depth, clear cover over the bar, spacing of adjacent bars and orientation of the 

heads on bond properties of headed bars. 



18 

 

 

Figure 2.9: Failure modes in headed bars (DeVries 1996) 

 

The tests were done for both shallow and deep embedments. Shallow embedment was defined 

as the ratio of embedment length to side cover less than five. When the ratio was greater than 

five, it was considered as deep embedment sample. Various bar sizes with various yield 

strengths were used. In shallow embedment test, some bars reached the yield stress plateau and 

went into strain hardening. But in general, bar yielding did not have a dramatic effect on the 

ultimate pullout load, as shown in Figure 2.10. Also, the observed result showed a trend that 

the bars with development length had higher pullout loads than the bars with no development 

length. The no development length condition was achieved by covering the bars with PVC 

pipes, thus not allowing the bar to bond with concrete. While the edge distance was found to 

be a factor controlling the size of the pullout failure cone, it was also found that the bars closer 

to the corner had lower pullout load capacity, as shown in Table 2.2. 

. 
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Figure 2.10: Pullout loads in bars with and without reaching the yield stress (DeVries 1996) 
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Table 2.2: Effect of bar to concrete edge distance on pullout capacity of headed bars (DeVries 

1996) 

Db 

(in) 

Head Dimensions 

(in) 

C1 

(in) 

C2 

(in) 

Le 

(in) 

Ld 

(in) 
T.R. 

fc
'  

(ksi) 

PU 

(kips) 

0.79 2 x 2 x 0.5 2 2 9 0 None 4.8 19.8 

0.79 2 x 2 x 0.5 2 18 9 0 None 4.8 41.4 

0.79 2 x 2 x 0.5 18 18 9 0 None 3.9 47.7 

 

 The parameters in Table 2.2 are defined as follows: 

Db=bar diameter, 

C1= near edge distance, 

C2= far edge distance, 

Le= embedment length, 

Ld= development length, 

T.R.= transverse reinforcement, 

fc’= concrete compressive strength, 

PU= ultimate pullout load. 

For deep embedments, the samples with no development length or transverse reinforcement 

failed rapidly with the side cover spalling in a brittle fashion, with no cracking until the failure 

was imminent. Although in some samples, small cracks appeared near the head region just 

before failure. For bars with development length, a crack formed at the start of the development 

length and propagated down to the head as the load increased (Figure 2.11).  
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Figure 2.11: Crack along the development length of a headed bar sample. (DeVries 1996) 

 

A wedge of concrete was observed to be formed at the head. The size of the wedge varied with 

size and aspect ratio of the head. A similar phenomenon was observed by Thompson et al. 

2006. 27 lap-slice specimens with headed bars were tested by Thompson et al. A typical 

specimen is shown in Figure 2.12. It was found that internal cracks always tend to propagate 

from the head of one bar towards the opposing bar at an angle of 55 degrees measured from 

the bar axis. On the other end, a well-defined, concrete wedge forms at the head of the opposing 

bar. This behavior indicates that the actual bond length that propagates the bond force is shorter 

than the provided splice length (Figure 2.13). 
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Figure 2.12: Typical lap-splice specimen used by Thompson et al. 2006 

 

Wright and McCabe 1997, observed a 26 to 50% increase in the bond strength using transverse 

confining reinforcement. This increase of bond capacity depends on the positioning and 

spacing of the transverse bars, as described by Thompson et al. 2006. Two types of 

confinements: hairpin and transverse & tie-down confinements (Figure 2.14) were used. The 

hairpin-confined specimens failed in a much similar fashion to the unconfined specimens. 

Rapid loss of bond stress (shear force per unit surface area of the interface) and surface cracks 

over the lap zone was observed. The transverse & tie-down specimens failed more gradually 

and spalling of cover concrete was largely prevented. Figure 2.14 shows that much of the 

potential benefits of the hairpins were lost due to their placement outside the bond length. These 

results indicate that confining reinforcement is not effective if not properly placed. 
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Figure 2.13: Mechanism of force transfer between opposing lapped bars (Thompson et al. 2006) 

 

 

Figure 2.14: Bond stress profiles for confined lap splices (Thompson et al. 2006). The bond 

stress, ubond is the shear force per unit bond interface area. 

 



24 

 

2.2.2 Cast-in-place Concrete Connections and Interface Bonding 

Cast-in-place or field-cast concrete closure pour is one of the simplest types of connections 

between two prefabricated concrete elements in Accelerated Bridge Construction (ABC). This 

is typically created by leaving a small gap between two precast concrete elements and the 

connection is achieved by using simple lap splices and pouring grout-type concrete material in 

the gap. This connection method can be used to connect various types of concrete elements. In 

this study, we will look at the longitudinal connection between the deck bulb-T girders. Various 

types of grout materials are used as closure pour e.g., regular grout, magnesium phosphate 

grout, epoxy grout, cable grout, Ultra-High Performance Concrete (UHPC) etc. (Swenty and 

Graybeal 2013).  As a highly suitable closure pour material, UHPC has gained wide popularity 

in ABC. UHPC’s suitability as a closure pour material stems from its high strength values 

(compressive strength of 24 ksi, splitting tensile strength of 1.3 ksi) and long term drying 

shrinkage of 550 microstrain (Graybeal 2014). But the downside of UHPC is that, its high 

material cost and installation cost make the construction more expensive. While the material 

cost of UHPC lies between $2,000 to $4,000 per cubic yard (Graybeal 2014; De la Varga and 

Graybeal 2016), according to ITD, its installation cost is around $15000 per cubic yard 

(Casanova 2018). 

In this study, HES concrete with fibers is considered as a proposed alternative to UHPC. The 

cost of using HES being comparable to that of conventional concrete ($600-$700 per cubic 

yard), the estimated saving in construction by using HES instead of UHPC can range from 

$50,000 to $100,000 (Casanova 2018). The figures mentioned here are based on actual ITD 

bids. This offers a significant economic advantage over the use of UHPC in exchange for a 

reduction in strength values. This study investigates if this reduced strength is sufficient for 

ABC in accordance with the design codes. 
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2.3 Interface Bond Tests (Casanova 2018) 

Casanova 2018, performed interface bond tests similar to tests performed by De la Varga et al. 

2016 and Graybeal 2017. The tests were performed according to the ASTM C78 testing 

method. Figure 2.15 shows a schematic diagram of the interface bond test setup. A loading rate 

of 30 lb/sec was maintained until beam failure occurred. 

 

Figure 2.15: Setup for the ASTM C78 flexural bond test (Casanova 2018). 

 

A total of 8 samples for the selected mix D were tested. Bonding agent was used in four of 

them and the rest four were without any bonding agent. Samples with no bonding agent showed 

higher interface strength. All the samples failed along the interface and the average modulus 

of rupture for the interface failure was found to be 612 psi (no bonding agent). 

2.4 Headed Bar Pullout Test (Casanova 2018) 

Six headed bar pullout samples were tested to study the behavior of the lower portion of a 

closure pour deck connection between Deck Bulb-T girders. Each specimen was composed of 

a closure pour concrete section in the middle, sandwiched between two precast concrete 

sections. Three headed rebars were arranged in the configuration shown in Figure 2.16. Each 

bar was a #5 bar and the diameter of the head was 1.5 inches. 
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Figure 2.16: Headed bar pullout specimen schematic (Casanova 2018). 

 

A constant loading of 0.01 in/min was applied until failure occurred. In all specimens, the 

failure of the top interface was the first failure to occur. After reaching the ultimate load, the 

specimens fractured suddenly and failed. The major cracks in the specimens were observed to 

be in line with the findings of DeVries 1996. All the specimens showed major cracks along the 

development length of the rebar and many of the specimens also showed conical cracks that 

formed near the head of the rebar and propagated at an angle of about 55° with the bar axis. 

2.5 Flexural Beam Test (Casanova 2018) 

Large beam specimens were tested under three-point and four-point bending. Each beam was 

78 inches in length, 12 inches in width and 8 inches in height. The closure pour section was 10 



27 

 

inches long with shear keys on both sides. A total of four headed bars, two from each side, 

created a lap splice inside the closure at the bottom. Regular reinforcing bars were used in a 

similar fashion at the top as shown in Figure 2.17. Three of the beams were tested for three-

point bending, and the rest three for four-point bending. For three-point bending, the point load 

was applied on a 1-inch thick steel plate of a dimension of 20 in x10 in sitting on the top of the 

beam. This was done to simulate a truck wheel load more realistically as prescribed by the 

American Association of State Highway and Transportation Officials (AASHTO). Loadings 

for all beam tests were applied at a rate of 0.1 in./min until failure. The schematic diagrams for 

three-point and four-point bending tests are shown in Figure 2.17. 

 

 

Figure 2.17: Beam flexural test schematics (Casanova 2018). 

 

(a) Three-point flexural test. 

(b) Four-point flexural test. 
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In all six cases, the first crack was observed to be formed at the interface- the right interface to 

be more specific. When the interface failure reached the shear key, the crack started to 

propagate inside the closure pour section until complete failure of the beam.  
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Chapter 3: Background on Finite Element Modeling 

3.1 Introduction 

The highly nonlinear and inelastic behavior of concrete splitting and bar slip makes the 

analytical study of bond and bond-slip behavior difficult. Over the years, a variety of techniques 

were used to develop finite element model of steel and bar slip. Various modes of fracture 

mechanics, continuous damage mechanics and smeared crack approaches were adapted with 

the use of link, contact or interface elements. In this chapter, one of the most popular and useful 

analytical approach, Finite Element Analysis (FEA) will be discussed. Previous studies to 

develop FEA models pertinent to this project will also be reviewed. 

3.2 Importance of Finite Element Modeling 

Finite Element Modeling, since its conception in the 1940s, has been deemed as a useful tool 

in various branches of engineering to find approximate solutions to boundary value problems. 

The demand for developing finite element models for various engineering problems has 

increased over time. It allows for studying probable behavior of an engineering problem 

without actually setting up experiments, thus saving cost, time and manpower. In this report, 

various approaches have been evaluated to model pullout tests of headed rebars in concrete. To 

test the accuracy of the developed models, test results from previous experimental studies have 

been compared with the FE results. 

3.3 Literature Review 

Many approaches have been designed to numerically model the steel-concrete bond behavior 

and its application in FEA. The modeling of this bond behavior offers several complexities. 

Firstly, the bond properties depend on a lot of parameters. Also, the bond-slip relationship is a 

highly nonlinear phenomenon. Generally, the “bond stress” obtained from experiments is an 

averaged value. Bond-slip is a localized phenomenon and the distribution of bond stress is not 
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uniform throughout the anchorage length. This distribution cannot be obtained exactly as it is 

virtually impossible to measure the steel stress at every point in the bar inside the anchorage 

length. In this case, strain gauges are placed in the reinforcement in regular intervals, and an 

average bond stress is calculated by dividing the difference of steel stresses at two points, 

obtained from the strain measurements at those points, by the total bond surface area between 

those points. Additionally, measuring strains just at the bond surface is very difficult. In most 

of the literature, the strain gauges are placed at the center of the steel bar, some distance away 

from the surface. 

Several studies have been carried out to model the distribution of bond stress along the 

anchorage length. Perry and Thompson 1966 studied the distribution of bond stress in eccentric 

pullout test specimens and in beams with flexural cracks. In eccentric pullout test, the bar at 

the loaded end was subjected to tensile loads of 2,000 lb, 6,000 lb and 9,000 lb. It was observed 

that, with the increase of the pullout load, the maximum bond stress point gradually shifts 

towards the unloaded end (Figure 3.1). 
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Figure 3.1: Pullout load and bond stress distribution in eccentric pullout test (Perry & 

Thompson, 1966). 

 

In cracked beam tests, a crack was introduced by means of placing a thin steel sheet, greased 

on both surfaced in the framework during casting. The test results showed that, the peak bond 

stress occurs near the crack and always at a distance of about 1.5 in from the crack (Figure 3.2). 
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Figure 3.2: Bar tension and bond stress distributions in beam at a crack (Perry & Thompson, 

1966). 

 

It is evident that, numerical modeling of the steel-concrete bond needs to accommodate the 

nonlinearity in bond stress distribution and the bond-slip behavior. However, the first finite 

element bond elements developed had linear stiffness values. Among those early models, Ngo 

and Scordelis 1967, proposed a simple two-dimensional bond element. Two orthogonal spring 

elements connected the adjacent steel and concrete node pair. The springs had no physical 

dimension which means the adjacent steel and concrete node could occupy the same location. 

Figure 3.3 is a schematic diagram of the spring element proposed by Ngo & Scordelis 1967. 
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Figure 3.3:  Linkage element developed by Ngo & Scordelis, 1967 

 

The two springs are parallel to a set of two orthogonal axes H and V. The local H axis of the 

spring element can be oriented at an arbitrary angle θ with the horizontal axis of the beam. The 

spring stiffness KH and KV of the two elements parallel to H and V axes respectively, defines 

the bond stiffness in horizontal and vertical directions. If σh and σv are the element stresses 

along the H and V directions, then the stress-strain relationship can be given by 

 

 

Where 𝜀𝐻 and 𝜀𝑉 are the relative displacements between points I and J in H and V directions 

respectively. If 𝛿1, 𝛿2 and 𝛿3, 𝛿4 are the displacements of nodes I and J in global horizontal and 

vertical directions respectively, then 

 
{
𝜎ℎ
𝜎𝑣
} = [

𝐾𝐻 0
0 𝐾𝑣

] {
𝜀𝐻
𝜀𝑉
} 

(3.1) 
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Where, c = cosθ and s = sinθ. This is a linear displacement model and cannot represent the 

highly nonlinear bond-slip behavior accurately. However, this model could represent the 

general trend of bond stress distribution. The force in the horizontal spring element could be 

taken as the bond. Studies with this model showed the peak bond stresses occur near the cracks, 

which conforms to the experimental studies. 

Later, contact elements were developed to model a continuous connection between steel and 

concrete elements. For example, contact elements proposed by Hoshino 1974 and Schäfer 1975 

can be mentioned. Dinges 1983 (as cited in Keuser and Mehlhorn 1988) proposed a generalized 

contact element. Figure 3.4 shows the contact element with two double nodes and a linear shape 

function. 

 

{
𝜀𝐻
𝜀𝑉
} = [

−𝑐 −𝑠 𝑐 𝑠
𝑠 𝑐 −𝑠 −𝑐

] {

𝛿1
𝛿2
𝛿3
𝛿4

} 

(3.2) 
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Figure 3.4: Contact element developed by Dinges 1985 

 

i, k and l, m represents two double nodes of the contact element of length L, parallel to an 

arbitrary local axis r. t is an axis orthogonal to r. Δik
r , Δlm

r , Δik
t and Δlm

t are the relative 

displacement between the double nodes in r and t directions respectively. If the bar diameter is 

ds, the nodal forces R in the local coordinates can be expressed as: 

 

 

Where, Gr and Gt are the bond moduli in r and t directions respectively. Keuser and Mehlhorn 

1988, analyzed the aforementioned bond-link element (Ngo & Scordelis 1967) and contact 

element (Dinges 1985) behavior with five shape functions. Among them, one was a constant 

slip function, two linear functions, one quadratic function and one cubic function (Figure 3.5). 
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Figure 3.5: Shape functions analyzed by Keuser & Mehlhorn 1988. 

 

Keuser & Mehlhorn concluded that, the contact element a linear displacement function can 

predict the bond-slip behavior more accurately than the bond-link element with constant 

displacement function. It was observed that, the accuracy of the result produced by the contact 

element can be increased further by using quadratic or higher order displacement functions. 

Another important aspect that influences the accuracy of the FE model is the material property 

of the bond element. The material property defines the stress-strain relationship (in this case, 

the bond stress-slip relationship) in the formulation of the stiffness matrix. From experiments 

on axially loaded cylinders, Doerr 1980 derived the following bond stress-slip relationship: 

 

 

Where, τb is the bond stress, fct is the concrete tensile strength and Δ is the slip, all in inch-

pound unit system. Martin 1973, derived a bond model from the studies conducted by Rehm 

1961. In the formulation of the bond stress- slip equation, Martin 1973, used three 

 𝜏𝑏
𝑓𝑐𝑡

= 3.28 × 102∆ − 1.953 × 104∆2 + 3.95 × 105∆3 
(3.4) 



37 

 

dimensionless calibration parameters a0, b0 and β that depend on compressive strength of 

concrete and bar rib geometry: 

 

 

Keuser & Mehlhorn 1988, used the equations proposed by Doerr 1980 and Martin 1973, and 

compared them to the results obtained by FEA using the bond-link element with constant 

stiffness developed by Ngo & Scordelis 1967 (Figure 3.6). It is evident that, bond elements 

with constant shape function and linear elastic material properties cannot model the steel-

concrete bond-slip behavior with sufficient accuracy. 

 

 

Figure 3.6:  Bond stress-slip relations (Keuser & Mehlhorn 1988). 

 

 𝜏𝑏
𝑓′𝑐,𝑐𝑢𝑏𝑒

= 𝑎0 + 𝑏0. ∆
1
𝛽⁄  

(3.5) 
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A large portion of the bond-slip nonlinearity arises from the primary and secondary cracks. As 

a consequence, research works have been carried out to develop Linear Elastic Fracture 

Mechanics (LEFM) model for steel-concrete bond. Ingraffea et al. 1984, studied the efficacy 

of LEFM models in FE analysis of steel-concrete bond. Ingraffea et al. argued that, while 

LEFM works well for metals and many rocks, it is not accurate in case of concrete. The 

secondary cracks formed near the ribs make LEFM unreliable for reinforced concrete. In 

LEFM, no stress transfer is assumed between the two faces of a crack after its formation. But 

in concrete, the secondary cracks are short in length and a significant amount of stress transfer 

takes place between the faces of the crack until a particular crack opening of about 0.001 in 

(0.025 mm) is obtained (Catalano 1983; Petersson 1981). This transfer of stress takes place due 

to aggregate interlocking and frictional force. 

Primary studies done by Ingraffea et al. showed the shapes and positions of the secondary 

cracks. The cracks formed near the ribs and were slanted towards the nearest free concrete 

surface i.e. the face of primary crack (assuming the concrete cover was large enough). 

Secondary cracks were more prominent in the region near the primary cracks. The formation 

of these secondary cracks gradually reduces the stiffness of the concrete; thus the bond stress 

shows peaks near the primary cracks. Ingraffea et al. studied the nonlinear behavior of load vs 

loaded end displacement and proposed a “tension softening interface” element that has a 

nonlinear material property. The nonlinear stiffness of the element was obtained from the curve 

in Figure 3.7 that has two components- Δelastic, the elastic displacement, and Δslip, the 

displacement due to secondary cracking. En is the stiffness of the tension softening element. 

The mathematical relationship between σ, Δslip, and En is given in Figure 3.7. The element was 

used wherever the reinforcement crossed a primary crack orthogonally. 
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Figure 3.7: Applied load, σ vs end displacement, Δ in tension pullout specimen (Ingraffea et al. 

1984). 

 

However, the model proposed by Ingraffea et al. did not take the effects of mechanical 

interaction between steel and concrete and radial stress in consideration. A bond model using 

plasticity theory incorporating the effects of mechanical interaction and secondary cracks was 

developed by Cox and Herrmann 1998. This was a two-dimensional axisymmetric model in 

“bar scale” i.e. the concrete and the bar were modeled separately, but for simplification, the 

ribs in the bar were not modeled. This elimination of bar ribs led to two idealizations regarding 

the general stress-strain response of the bond model. First, the homogenization of the bar-

concrete interface traction in the ribs. The traction force exerted by the rib face on the 

neighboring concrete key was distributed as uniform shear stress τ along the interface element 

(Figure 3.8). 
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Figure 3.8: Idealized distribution of the horizontal traction component over the unit surface 

element: (a) actual, and (b) bar-scale model (Cox & Hermann 1998). 

 

A unit surface element representing a complete bar surface for one cycle of rib geometry is 

shown in Figure 3.8. Sr is the rib spacing. If Tz is the traction force of the rib, then in the 

idealized model, considering a cylindrical coordinate system with z-axis parallel to the bar axis, 

the relationship developed by Cox & Hermann 1998 is: 

 

 

Where A denotes the unit surface area and r is the radius of the bar. The second idealization is 

the effect of secondary cracking near the ribs. While Ingraffea et al. 1984, considered the effect 

of cracking on horizontal displacement of the bar, Cox & Hermann 1998 considered the relative 

movement of concrete in bond zone in both the horizontal direction and the normal direction 

(bond zone dilation). Thus, the strain matrix was considered as a function of tangential 
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(direction of the bar axis) and normal displacements (δt and δn respectively) of concrete relative 

to the bar surface, normalized by the bar diameter Db. That is, 

 

 

Figure 3.9 depicts an idealized deformation where δt < 0 and δn > 0. 

 

Figure 3.9: Idealized deformation of the bond zone: (a) actual, and (b) bar-scale model (Cox & 

Hermann 1998). 

 

For the yield surface model, various linear combinations of the following two criteria (the 

“exponential” criterion and the “power” criterion respectively) were considered: 

 

 
{𝑢} =

1

𝐷𝑏
{
𝛿𝑡
𝛿𝑛
} 

(3.7) 

 |
𝜏

𝑓𝑡
| = 𝐶𝑒(𝑑)[1 − 𝑒

−𝛼𝑒(−
𝜎
𝑓𝑡⁄
+𝜎′(𝑑))

] 
(3.8) 



42 

 

 

 

 

Where, ft is the concrete tensile strength, αe and αp are two calibration parameters, σ’ is the 

kinematic softening function and Cp and Ce are the isotropic hardening and softening functions. 

σ’, Cp and Ce were considered as the functions of a single parameter d for simplification. d is 

the “damage factor” proposed by Eligehausen et al. 1982. As the slip progresses the length of 

a unit cell, sr, the concrete key between the ribs fails by the combined action of crushing and 

shear or gets wedged radially outwards by the ribs. Thus, the effect of mechanical interlock 

diminishes, and only the effect of friction remains. The “damage factor”, d represents the 

monotonic envelope of this phenomenon. Based on experimental observations, Cox & 

Hermann 1998 defined the value of d as: 

 

 

This bond model developed by Cox & Hermann 1998, reproduced the bond vs slip relation 

well. Although, it only considered the bond phenomena inside the “bond radius” zone (Goto 

1971). This zone does not contain the primary cracks and the transverse cracks that cause 

pullout cone. Additionally, the effects of non-axisymmetric rib patterns and cracks were 

averaged in this model.  
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3.4 Introduction to ANSYS 

In this study, ANSYS 18.1, a general-purpose FEA software was used. ANSYS was first 

developed by the ANSYS Inc.® in 1970. Since then, it was developed to solve FE models 

related to structural analysis, fluid mechanics, thermodynamic and electromagnetic problems. 

It can solve both static and dynamic problems as well as linear and nonlinear models. For its 

diverse problem-solving capacity, ANSYS is one of the most popular FE software used in both 

industry and academic research. In this study, only the nonlinear static structural module of the 

ANSYS 18.1 suite was used.  

3.5 Modeling Options in ANSYS 

ANSYS offers a variety of options in terms of element and material selection. Some of the 

options that were considered in this study are discussed in the following sections. 

3.5.1 Concrete 

3.5.1.1 Smeared Crack (SOLID65) 

SOLID65, also known as CONCRETE65, is an 8-node brick element to model 3D solids with 

or without reinforcing bars (ANSYS Inc. 2016). The reinforcing bars can be modeled using the 

native “smeared rebar” option where the rebars can be defined to be smeared throughout the 

element in three different directions. This can be input as three real constants each having four 

parameters named MAT, VR, THETA, and PHI. MAT and VR are the material properties and 

the volumetric ratio of rebars with respect to concrete in a particular direction respectively. 

THETA and PHI are the directions in terms of angels from the x-axis towards the y and z-axes 

in the global coordinate system. Moreover, the SOLID65 element has a unique capability of 

crushing and cracking in compression and tension respectively. The crack at an integration 

point is represented by introducing a plane of weakness in the direction of cracking i.e. the 

material turns from isotropic to orthotropic (ANSYS Inc. 2013). When the element crushed 
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due to compression at an integration point, it is defined as the complete deterioration of the 

structural integrity of the material and the structural stiffness at the integration point in question 

can be ignored. To determine the failure in tension and compression, the William-Warnke 

failure criterion is employed (Willam and Warnke 1975). These features make it a very suitable 

element to model concrete. But it is also to be noted that, these features introduce a lot of 

nonlinearities in the FE model and often create convergence problems. 

 

Figure 3.10:  Geometry of SOLID65 element (ANSYS Inc. 2016). 

 

3.5.1.2 Cast Iron Model 

With the default material specification option in ANSYS, the plasticity curve is mirrored in 

both tension and compression. But this is not suitable for materials like concrete that have 

different compressive and tensile strengths. To model different tensile and compressive 

properties, the Cast Iron material model in ANSYS can be used. it was originally developed to 

model grey cast iron which is a two-phase material with different compressive and tensile 

behavior (Hjelm 1994). There are three input parameters- plastic Poisson’s ratio, uniaxial 

compression and uniaxial tension. The latter two are input as sets of stress-strain points 
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representing multi-linear isotropic hardening behavior. These points are obtained from the uni-

axial compression and tension tests of the material respectively. Plastic Poisson’s Ratio is a 

FEM concept to address plasticity problems with a changing Poisson’s ratio. The actual, elastic 

Poisson’s ratio has to be defined with the elastic properties of the material. 

3.5.1.3 Drucker-Prager Concrete 

The classic Drucker-Prager law (Drucker and Prager 1952) is applicable for granular materials 

like soil and concrete. However, the single-surface classic Drucker-Prager model cannot often 

represent the large difference in the tensile and compressive strengths of concrete (ANSYS Inc. 

2013). The Drucker-Prager concrete model combines two yield surfaces to represent concrete 

behavior more realistically. The basic Drucker-Prager concrete requires three inputs- uniaxial 

tensile strength, uniaxial compressive strength, and biaxial compressive strength. However, the 

Drucker-Prager concrete can also model the post-failure softening behavior. In that case, it 

requires six additional parameters. These parameters are explained in Table 3.1 and also 

graphically represented in Figure 3.11. 

Table 3.1: Linear Softening Model parameters for Drucker-Prager concrete (ANSYS Inc. 2013) 

Parameter Property Range 

Kcm Plastic strain at uniaxial compressive strength 0< Kcm< Kcr 

Kcr Ultimate effective plastic strain in compression Kcr> Kcm 

Ωci Relative stress at onset of nonlinear hardening 0≤ Ωci≤1 

Ωcr Residual compressive relative stress 0≤ Ωcr≤1 

Ktr Plastic strain limit in tension Ktr≥0 

Ωtr Residual tensile relative stress 0≤ Ωtr≤1 
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Figure 3.11: Softening in Compression and Tension for Drucker-Prager concrete (ANSYS Inc. 

2013). 

 

3.5.2 Concrete-Concrete and Steel-Concrete Bond 

3.5.2.1 Nonlinear Spring (COMBIN39) 

COMBIN39 is a nonlinear spring model that can be used in 1-D, 2-D or 3-D simulations. It 

can have a zero or non-zero length. The non-zero length spring elements are generated between 

two coincident nodes and have 1-D application only. The spring stiffness is input as points in 

a Force-Displacement curve. This element can be used as an interface element between steel 

and concrete similar to that proposed by Ngo and Scordelis 1971. 

3.5.2.2 Contact Debonding and Interface Delamination 

Contact debonding and interface delamination are two techniques in ANSYS that can simulate 

progressive separation of a bond. Both methods overlap and are essentially the same in most 

of the aspects. The difference is that debonding is associated with contact elements and 

delamination is associated with interface elements. Contact elements are used to define other 
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contact features (friction, perfect bond, friction-less sliding etc.) too but the interface elements 

do not have these capabilities. Debonding and delamination can be modeled using two 

methods- Cohesive Zone Model (CZM) method and the Virtual Crack Closure Technique 

(VCCT) method. The CZM method is bond shear-separation distance based, while the VCCT 

method is based on fracture energy. The CZM method is simpler and more suitable for 

modeling the steel-concrete bond. There are two methods of formulation for the CZM method- 

bilinear and exponential. They are essentially the bond traction (τ) and relative displacement 

of the two surfaces (δ). Both the curves have two arms, one that reaches to the maximum bond 

stress and the other one represents the subsequent softening of the bond (Figure 3.12). 

 

Figure 3.12:  Bilinear CZM method graph (ANSYS Inc. 2013). 
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Chapter 4: Methodology 

4.1 Introduction 

Finite element models for the experimental pullout tests and the beam bending tests done by 

Casanova 2018 were developed. Issues arose regarding the finite element modeling of the steel-

concrete bond, concrete-concrete bond in both the tests and the loading pattern in the three-

point bending test. Various options were explored to overcome the issues and to obtain the 

most accurate results in the nonlinear region of the simulations. 

4.2 Development of FE Models 

4.2.1 Pullout Tests 

Pullout tests can give the nature of the bond developed between the reinforcing bar and the 

concrete matrix surrounding the bar. In this case, it can also provide insight about how much 

anchorage the head of the rebar is providing. As a part of the experimental phase of the project, 

several pullout tests were carried out by Casanova 2018. In this chapter, finite element model 

will be developed to represent the pullout tests. Before developing the models for experiments 

by Casanova 2018, a simple pullout test based on the studies by Delhomme et al. 2016 was 

modeled for calibration and verification purpose. 

4.2.1.1 Pullout Test by Delhomme et al. 2016 

Delhomme et al. 2016 conducted several experiments on pullout behavior of headed anchor 

bolts in concrete at University of Lyon, France. The specimen T3-80-U was chosen to be 

modeled in ANSYS. A 60 mm diameter anchor head was attached to the end of an 80 mm long 

plain bar with 20 mm diameter. The depth of the head was 20 mm. Due to the use of plain bar, 

the sides of the bar was not bonded to the concrete. The specimen was embedded in a 600 mm 

deep concrete block. Figure 4.1 shows the experimental setup. 
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Figure 4.1: Experimental setup of the pullout test (Delhomme et al. 2016). 

 

The free end of the bar was pulled and the displacement at the free end was monitored with 

two Linear Variable Differential Transformers (LVDT). In ANSYS 18.1, elements SOLID65 

and SOLID185 were used to model the concrete and steel respectively. The reason behind 

using SOLID185 is that it is also an 8-node brick element that has a geometry similar to 

SOLID65. The parameters for the material properties were taken from the experimental data. 

The parameters are given in Table 4.1. 

 

 

Table 4.1:  Parameters for the FE Model of Experiments by Delhomme et al. 2016 

Parameter Concrete Steel 

E (MPa)  35,300 200 x 103 

Poisson’s Ratio 0.2 0.3 

f’c (Mpa) 55.2 415 

ft (MPa) 4.5 415 
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The compressive crushing was turned off in the concrete model, while it could crack in tension. 

The edges of the upper face of the concrete block were constrained in all direction. The upper 

surface of the bar was given an outward displacement of 3 mm. The “Large Deflection” option 

was turned on to account for the geometric nonlinearities due to deflection. The sides of the bar 

were not bonded; i.e., they could slide freely over the neighboring concrete surfaces. But the 

upper portion of the head was bonded to the concrete for allowing complete activation of the 

head.  Chapter 5 presents a summary of the results. 

 

4.2.1.2 Pullout Test by Casanova 2018 

Two finite element models for the pullout tests done by Casanova 2018 were created- one with 

assuming perfect bonding between the sides of the rebar and the upper surface of the head and 

the concrete, one with using nonlinear spring element COMBIN39 between steel and concrete 

to simulate bond-slip response. A chronological overview of the modeling attempts is given 

below- 

• A quarter and a half model of the pullout specimen were modeled in ANSYS. In both 

cases, all the parts (the precast, the closure pour and the headed bars) were perfectly 

bonded. SOLID65 elements were used to model the concrete parts, and the steel rebars 

were modeled using SOLID186, another 8-noded 3D solid element. Obviously, these 

models showed stiff responses and produced much conservative results. The ultimate 

force was found to be 9,500 lb. But the force versus stress in the steel graph was much 

steeper than the experimental results. Also, these models failed to display the behavior 

in the nonlinear region. 

• In the second attempt, the interface between the closure pour and the precast section 

was introduced as a thin layer of SOLID65 element that had the same tensile strength 
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as the flexural interface strength found from the flexural bond test. The value of the 

interface bond strength found experimentally was 612 psi. All other parameters of the 

model were the same as before. The interface layer was 0.5 inch thick. Up to this point, 

in the material properties definition, the tensile strengths for precast and closure pour 

concrete were considered to be 614 psi and 784 psi respectively. These values were 

found experimentally from splitting tensile test. This model could imitate the 

experimental results in the linear region very accurately but encountered convergence 

issues once it reached the nonlinear region. Moreover, it overestimated the ultimate 

strength by about 20%. 

• To compensate for the overestimation of the ultimate strength, the tensile strengths for 

the closure, precast and interface sections were reduced to 556 psi, 435 psi and 256 psi 

respectively. The justification for this reduction will be discussed later in this chapter. 

Like the previous model, this model also showed a very good agreement with the 

experimental results in the linear region, and the ultimate strength came down to a 

reasonable value of 11,600 lb. But it still could not avoid the convergence issues in the 

nonlinear region. 

• Another model, which was same was the previous model, was developed. But this time, 

the Arc-Length method was activated in the solution phase. The Arc-Length method, 

also known as the Modified Riks Method, is a geometric expansion to the Newton-

Raphson method and a very powerful tool for highly nonlinear finite element problems 

(Riks 1979). This model showed better results than the previous ones. But still, it could 

not give enough data points in the nonlinear region. 

• At this point, it was evident that, the bond-slip between rebar and concrete plays a 

significant role in the results. However, from the literature also manifested that, FE 

modeling of bond-slip is a complicated task. New ways to better model the closure pour 



52 

 

to precast interface were also explored. For these purposes, two options namely 

nonlinear spring interface element and Cohesive Zone Modeling (CZM) were explored 

and a final model was prepared using these options. The details of this model will be 

discussed in this chapter. A schematic diagram of the FE model is shown in Figure 4.2. 

 

Figure 4.2: Schematic diagram of the pullout test FE model. 

 

Cohesive Zones were defined in the two closure-to-interface regions. Mode I Cohesive Zone 

Model was used which debonds only due to normal stress. The maximum normal stress for 

debonding was defined as 256 psi, and the contact gap at the completion of debonding was 

defined as 0.1 inch. The interface strength was determined from the modulus of rupture 

determined from 6 four-point bending tests which was found to be 612 psi. The reduced value 
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of 438 psi was based on the studies conducted by Kim and Reda Taha 2014. They studied the 

relationship between the modulus of rupture, splitting tensile strength and direct tensile strength 

of concrete. The relationships are given by the following equations: 

 

 

Where, fr, fsp, ft and f’c are the modulus of rupture, splitting tensile strength, direct tensile 

strength and compressive strength of the concrete respectively in terms of MPa. The value of 

438 psi is found from the relation between fr and fsp. The tensile strengths of the closure pour, 

and precast concretes used in the model (Table 4.2) were obtained from the experiments of 

Casanova 2018, which were the splitting tensile strength. To be consistent, the rupture modulus 

of the interface was used to obtain its splitting tensile strength. The steel was modeled as a 

linear isotropic material with a modulus of elasticity of 29x106 psi and Poisson’s ratio of 0.3. 

 

Table 4.2:  Parameters for the FE Model of pullout test by Casanova 2018. 

Parameter Closure Pour Precast 

E (psi) 4.33x106 3.3 x 106 

Poisson’s Ratio 0.194 0.191 

f’c (psi) 8,453 5,258 

ft (psi) 778 614 

 

 𝑓𝑟 = 0.85√𝑓′𝑐 (4.1) 

 𝑓𝑠𝑝 = 0.49√𝑓′𝑐 (4.2) 

 𝑓𝑡 = 0.35√𝑓′𝑐 (4.3) 
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From the previous attempts, it was evident that, the meshing of the model plays a very 

important role in the speed and accuracy of the simulation. The brick elements created by 

“sweep meshing” have a greater tendency of convergence than its tetrahedral counterparts. 

Also, brick meshes have better aspect ratio in general and also reduce the total number of nodes 

and elements to a great extent. This is especially important for SOLID65 elements, as they are 

highly nonlinear and often unstable due to their cracking and crushing capabilities. But, manual 

meshing, especially sweep meshing is a complicated task. It requires experience and patience 

from the person creating the mesh. A body cannot be swept, if (ANSYS Inc. 2016): 

• There is a completely contained internal void in the body. 

• A source and target pair cannot be found. That is, the sweeper cannot find at least one 

path from a source surface to a target surface connected by edges or closed surfaces. 

• If a “Sizing control” is used on a body with hard edge sizing and the source and target 

faces contain hard divisions which are not the same for each respective edge. 

To make a body “sweepable”, it is often required to divide the body into several parts until 

each part satisfies the requirements to be swept. But, too many divisions can make the setup of 

the FE model very complicated, especially in terms of contact definitions. So, a compromise 

must be found based on the particular model. A model can perform in a satisfying manner if 

the number of tetrahedral SOLID65 elements is below 10% of the total number of elements 

(ANSYS Inc. 2016). So, a 3D quarter model was created and divided in such a way so that 

more than 90% of it can be meshed using brick elements. Also, the sizing of the meshes had to 

be defined carefully so that the steel elements and the neighboring concrete elements have 

coincidental nodes that will be used for defining the spring elements. The final meshing is 

shown in Figure 4.3. 
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Figure 4.3:  Meshing of the quarter scale pullout model. 

 

Frictionless supports were provided at the surfaces at the planes of symmetry. This allowed the 

nodes at those surfaces to move in the plane of symmetry but restricted their movement normal 

to the symmetry planes. Constraint equations were used between the coincidental nodes of the 

steel and the concrete elements to restrict their movement in the normal direction. To control 

the movement in the tangential direction, i.e., to define the bond-slip relationship, single degree 

of freedom (DOF) in the tangential direction COMBIN39 elements were introduced between 

the coincidental nodes. At every 1-inch interval along the length, the quarter of the 

circumference of the middle rebar had three spring elements attached to it (Figure 4.4). The 

force versus displacement curve for each spring element was calibrated using the method 

described in Appendix B (Figure 4.5). For the calibration, bond-slip relations described by 

Hong et al. 2008 was used, and a simple pullout test was modeled. The results of this pullout 

test were verified against the experimental values found in the literature. Two nodes on the 
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middle rebar near the head were monitored for displacement to get the strain at that point. Total 

force was obtained from the support reactions. From the strain data, force in the head was 

calculated using the following equation: 

 

Where FH = Force in the head, A= cross-section area of the bar, ε= strain and E= modulus of 

elasticity of the steel. An average total force versus force in the head curve was calculated from 

the results of the six experiments and the FE model results were compared to that curve. The 

summary of the results is given in Chapter 5. 

 

Figure 4.4: Schematic diagram of the placement of COMBIN39 elements. 

 

 𝐹𝐻 = 𝐴𝜀𝐸 (4.4) 
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Figure 4.5: Force-Displacement curve used for each spring element. 

 

4.2.2 Beam Tests by Casanova 2018 

Some simplifications and modifications to the beam geometry and load placement were done 

in the FE model for the beam tests. In the experiments, the supports were provided by two 1-

inch diameter solid steel rods beneath the beam. Each circular rod was 3 inches inside from the 

outer face, thus rendering the effective length of the beam to 72 inches. Therefore, the 3D 

model had a length of 72 inches. Another issue was that, in the three-point bending, the steel 

plate on the top of the beam has a frictional contact with the beam. That is, the plate and the 

beam can slide against each other, making different deflections in the beam and the plate 

possible. In the FE model, the simplest approach would be to assume a perfect bond between 

the plate and the beam. But in that case, the middle 20 inches of the beam acts as a rigid section, 

with no noticeable variation of deflection within that region. Using a frictional contact model 

creates too much nonlinearity in the model and gives birth to convergence issues. A 4-inch 
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diameter load cell was used on top of the plate in the tests. Considering all these, for the 

modeling of the three-point bending test, several load placements were modeled: 

1. The load was evenly distributed on the steel plate and the steel plate was-  

a. perfectly bonded to the beam 

b. in frictional contact with the beam 

c. in frictionless contact with the beam. 

2. The load was at the center of the steel plate over a 4-inch diameter circular area and the 

steel plate was-  

a. perfectly bonded to the beam  

b. in frictional contact with the beam  

c. in frictionless contact with the beam.  

3. There was no steel plate on the beam. The load was defined at the middle on a 4-inch 

diameter circular area. 

4. The load was placed as a concentrated “line load” right at the midspan.  

It was found that the third option gave results closest to the experimental values in terms of 

cracking and ultimate loads. For the other two options, the perfectly bonded ones responded in 

a very rigid manner; and the other two models of load placements 1 and 2 showed contact 

instability. On the other hand, placing the load at the midspan produced a more accurate 

moment versus rebar stress diagram than option 3. However, the ultimate force was lower than 

the experimental values as the moment arm was longer. The fourth option was preferred 

because in this case, the moment values are more critical in bridge design than the load values. 

Figure 4.6 shows the simplified geometry and the loading scheme used in the FE models. All 

the other components were modeled as the experimental setup. 
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Figure 4.6:  Load placements in the FE models of the (a) three-point, and (b) four-point flexural 

beam tests. 

 

An overview of the modeling attempts is given below: 

• The first model consisted of tetrahedral SOLID65 elements and a thin layer of 0.25-

inch thickness at the interface. The steel was modeled using SOLID186 elements. This 

model showed a much stiffer response than the experiments as the SOLID65 elements 

do not truly open up after cracking. 

• The next model also had tetrahedral SOLID65 elements and the thin interface layer. 

But the steel was modeled using link and beam elements instead of 3D elements. On 
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two separate cases, the steel rebars were modeled with LINK180 and BEAM188 

elements respectively. LINK180 is a 2-node spar element capable of tension and 

compression. On the other hand, BEAM188 is a 2-node beam element with 6 degrees 

of freedom at each node (ANSYS Inc., 2016). However, the link and beam elements 

cannot imitate the anchoring behavior of the headed bars. So, the results were 

inaccurate. 

• In the next model, both the steel and concrete were modeled using SOLID187, a 

quadratic brick element that has a tetrahedral variation. As the concrete parts were not 

“sweepable”, tetrahedral elements were used and cast-iron material properties were 

defined for concrete. A bilinear Mode I Cohesive Zone Model was used and the 

debonding stress was set at 438 psi. The reasoning behind choosing this value is 

discussed in Appendix B. All other material properties remained the same. The steel 

bars were perfectly bonded with the concrete. The results obtained from this model will 

be discussed later in the next chapter. 

• Finally, instead of SOLID187, the concrete was modeled with SOLID65 using the 

smeared crack technique. Bond-slip model between the concrete and the bottom rebars 

was introduced using the nonlinear spring COMBIN39 elements. Later in this chapter, 

the details of this model will be discussed. 

4.2.2.1 FE Model with No Bond-Slip 

As described earlier, this model was built using SOLID187 elements. Cast Iron model was used 

for concrete. Concrete material properties were the same as the values given in Table 4.2. For 

the steel, the elastic modulus was 29x106 psi, Poisson’s ratio was 0.3 and the yield strength 

was 60 ksi. Simple supports were provided at the two outer edges (pinned at one edge, roller 

at the other). A ramped load of 15 kips was placed at the locations shown in Figure 4.6. For the 

three-point bending test, a pressure of 1.193 kips was provided at the center on a circular area 
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of 4 inches diameter. For the four-point test, 7.5 kips of force was exerted on each of the two 

indicated locations. Figure 4.7 shows the different parts of the 3D model used for the analyses. 

 

Figure 4.7:  Different components of the beam 3D model. 
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4.2.2.2 FE Model with Bond-Slip 

In this model, COMBIN39 elements were used to simulate bond-slip. The spring elements were 

only applied to the bottom bars. As the top portion of the beam is in compression, the upper 

bars do not take much load. So, their bond-slip was not considered significant and perfect 

bonding was assumed. The surfaces of the bottom rebars and the surfaces of the voids in 

concrete that encase the rebars were carefully meshed first so that coincidental nodes could be 

created between the rebars and the surrounding concrete. For the concrete parts, cracking in 

tension and plastic yielding in compression were defined using the smeared crack concrete 

material definition. Figure 4.8 shows the Force vs Displacement curve used for each of the 

spring elements. The springs were only allowed to move in the direction of the length of the 

beam. They had no DOF in the other two directions. But this was a bending test. So, if “Large 

Deflection” was turned on in the ANSYS solution options, it would take the bent shape of the 

beam into account in each substep. In that case, the displacement of the springs in the other 

two directions would become significant and the assumptions for the spring elements would 

have become invalid. To avoid this complication, “Large Deflection” option was turned off. 

 

Figure 4.8:  Force versus Displacement curve for the springs used in the beam model. 
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Chapter 5: Results 

5.1 Introduction 

In this chapter, the results of the models described in Chapter 4 will be presented. The results 

obtained from the FE models will be compared with the experimental results. Also, the 

differences in results obtained due to various modeling techniques will be discussed.  

 

5.2 Results of Pullout Tests 

Two pullout tests were modeled- one by Delhomme et al. 2016, and another by Casanova 2018. 

While Delhomme et al. 2016 used PVC sheathing to prevent the bonding between steel and 

concrete, in the experiments by Casanova 2018, the rebars were bonded to the concrete. 

Therefore, FE models were developed with perfect bond between steel and concrete, and with 

bond-slip simulated by nonlinear spring elements for the pullout tests by Casanova 2018. 

5.2.1 Test by Delhomme et al. 2016 

The displacement at a node at the free end was observed and the total force was found from the 

support reactions. Then the force versus free end displacement graph was plotted to compare 

with the experimental results (Figure 5.1).  
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Figure 5.1: Comparison of experimental (Delhomme et al. 2016) and FE model results. 

 

It can be observed from the graph that the finite element model captured the general shape of 

the curve in a reasonably accurate manner. But it overestimates the ultimate pullout force by 

about 20%. The crack plot of the model in Figure 5.2, where the cracks are represented by the 

red circles, shows failure cone near the head at an angle of about 45 degrees, which is in 

agreement with the observations made by DeVries 1996.  



65 

 

 

Figure 5.2: Crack plot for the FE model based on experiments by Delhomme et al. 2016. 

 

5.2.2 Tests by Casanova 2018 

To compare the effect of bond-slip on the results, the results from the FE model with a thin 

interface layer and no bond-slip is plotted against the experimental average results in Figure 

5.3. It is obvious from the plot that, the FE model shows a stiffer response, especially in the 

nonlinear region. It is necessary to mention here that, the nonlinearity in this case arises from 

the tensile cracking of concrete. The pullout failure occurs before the steel yielding.  The stiff 

response in the model with perfect bonding can be explained as a combined effect of two 

factors: 

1. The lack of bond-slip interaction.  

2. Interface crack not truly “opening up”. The SOLID65 element employs a smeared crack 

approach. That is, the stiffness is reduced to zero in the direction normal to the crack. 
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So, this is a “virtual” crack which reduces in strength but does not necessarily show a 

contact gap. 

 

Figure 5.3: Total force versus force in the rebar (FE model with thin interface layer and no 

bond-slip). 

 

On the other hand, Figure 5.4 shows the improvement in results due to the incorporation of the 

spring elements and the Cohesive Zone Model. Like other attempts, it is in very good 

agreement with the experimental results in the linear region. In addition, the nonlinear part also 

mostly remains inside the spectra of the experimental values. 
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Figure 5.4:  Total force versus force in the rebar (FE model with COMBIN39 and CZM). 

 

It can also be noticed from the FE model that, although both the precast and the closure pour 

concrete crack after reaching their tensile strengths, there is no compressive crushing in 

concrete. The maximum compressive stress observed in the concrete was 2100 psi, which is 

significantly less than the compressive strengths of both precast and closure pour. A study of 

the crack plot shows that it is in agreement with the experimental observations. It can be seen 

from Figure 5.5 that, a crack started from the top of the specimen near the bar and continued 

to propagate downward. When the crack reaches the interface, the interface fails quickly, and 

the previous crack again continues to propagate down towards the head. But the pullout cone 

cracks near the head were observed in the experiment, which were not found in the FE analysis. 

In Figure 5.5, the red circles represent primary cracks, while the green and blue circles denote 

the secondary and tertiary cracks respectively. Also, the orientation planes of the circles 
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represent the plane of the cracks. The yellow area at the interface zone denotes the failure of 

the interface at that region. From the figure, it is observed that, the crack propagation is similar 

and in line with the experimental observation. 

 

 

Figure 5.5: Crack propagation in the FE model of the pullout test by Casanova 2018. 
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5.3 Beam Bending Tests by Casanova 2018 

Stresses at two points of the first bottom rebar on the right side were monitored. One of the two 

points was close to the head, and the other point was right at the interface of precast and closure 

pour. These stresses were plotted against the moment at the midspan of the beam. When 

compared to the experimental values, the moment versus rebar stress curves for the model with 

no bond-slip in Figure 5.6 point to some interesting observations.  

 

Figure 5.6:  Moment vs Rebar stress for three-point bending test (no bond-slip). 

 

Firstly, the stress at the head becomes constant in the FE model after the failure of the interface. 

This possibly happens due to the perfect bonding between the rebar and the concrete. After the 

separation of precast and closure pour at the interface, the closure pour section pulls the rebar 

like a vice. That is why the head does not get a chance to activate its anchoring effect, and no 
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further stress develops. However, at the interface, the steel is free to stretch and thus start to 

take more stress. The stress at the interface matches closely with the experimental results. This 

statement also holds for the four-point bending test, as shown in Figure 5.7. Secondly, the rebar 

stress at the interface should be greater and more critical. Because after the interface failure, 

the rebar takes all the load at that region. This is also reflected in Figure 5.6. But these results 

are not reliable. Because the experimental values were calculated near the head. So, it is evident 

that, bond-slip behavior plays a crucial part in the beam results. 

 

Figure 5.7: Moment vs Rebar stress for four-point bending test (no bond-slip). 

 

Figure 5.8 shows the moment vs rebar stress plot for three-point bending FE model with bond-

slip. It can be seen that, the introduction of bond-slip has brought the stress at the head closer 

to the experimental values. And as expected, the rebar stress at the interface is higher. Similar 

to the pullout tests, the nonlinearities here are also a combination of geometric and material 

nonlinearities caused by the interface failure and the cracking of concrete. In the experimental 

phase, all six specimens cracked at the right-hand side closure to precast interface. Looking at 
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the crack propagation in the finite element model shown in Figure 5.9, the right-hand side 

interface opens up more. So, the FE model is in good agreement with the experimental results. 

 

Figure 5.8: Moment versus Rebar stress for three-point bending test (with bond-slip). 

 

 

Figure 5.9: Interface crack propagation in the three-point bending test. 

 

The reason why the right-hand side interface cracked every time can be explained by the 

asymmetric splice configuration of the rebars. In such a short width (12 inches), this 
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asymmetric condition can create torsion in the beam, which causes the right-hand side interface 

to crack first. This is also confirmed from Figure 5.10, where it shows that the debonding of 

the right-hand side interface is occurring first. Furthermore, Figure 5.10 also shows that, after 

the interface failure in the FE model, concrete cracks form near the shear keys, especially the 

right-hand side shear key, and travel inwards inside the closure pour. Comparable crack 

patterns were found in the experiments by Casanova 2018. 

 

Figure 5.10: Concrete crack patterns in the beam FE model. 
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Chapter 6: Summary, Conclusions, and Recommendations 

6.1 Introduction 

A number of modeling options were explored to develop finite element models of pullout of 

headed rebars in concrete and beam bending tests. Most of the models showed good agreement 

in the linear region. But there were some issues in the non-linear region of the analysis, 

especially when the bond-slip response was ignored. These issues and their probable causes 

are discussed in this chapter. Finally, some recommendations for future studies are made based 

on the results of the analyses and the issues encountered during the study. 

6.2 Summary 

• An FE model of the pullout test of headed rebar by Delhomme et al. 2016 was created 

using the smeared crack approach for concrete. The rebar was not bonded to the 

concrete. The pullout force versus loaded end displacement curve showed that the FE 

model matched the experimental results very accurately, especially in the linear region. 

However, the ultimate pullout force was about 25% higher than the experimental 

results.  

• The pullout test conducted by Casanova 2018 was modeled. First, the FE model was 

created assuming a perfect bond between the rebar and concrete. While this model was 

able to replicate the experimental results in the linear region, in the nonlinear region the 

FE model showed a much stiffer response. Then, the model was improved by using 

nonlinear spring elements between the rebar and the concrete to simulate the bond-slip 

response. This improved model showed much better results in the nonlinear region. In 

both the models, SOLID65 element was used to model concrete. The crack pattern in 

the FE model was in agreement with the experimental observations. The upper interface 



74 

 

was the first to fail. Another major crack formed at the top of the middle rebar and 

propagated downwards. The interface was modeled using CZM. 

• Finally, FE models were created for the flexural beam tests by Casanova 2018. Like the 

pullout test, the concrete and the interface were modeled using SOLID65 and CZM 

respectively. Bond-slip was modeled using COMBIN39 spring elements. The FE 

results were in good agreement with the experimental ones. The ultimate moment was 

15% lower in the FE model than the average ultimate moment found from the 

experiments. The crack patterns were similar to the experimental observations, where 

the right interface failed first. 

6.3 Discussions on Results 

From both pullout models (Delhomme et al., 2016 and ITD Pullout Test) it is evident that the 

FE models can replicate the linear region very well. The FE model of the ITD pullout test 

performs even better in the linear region than the FE model of experiments carried out by 

Delhomme et al., 2016. This is because the material parameters e.g. elastic modulus, Poisson’s 

ratio, tensile and compressive strengths were directly found from experiments, whereas, all the 

required parameters were not available in the literature for the experiments by Delhomme et 

al., 2016. This indicates that the linear material models used in the FE models were correct. 

There were some issues when the FE analyses entered the nonlinear region. The most 

prominent of these issues was difficulty with convergence. By default, ANSYS employs the 

Newton-Raphson method to solve non-linear problems. This is an iterative method and ANSYS 

checks against a force and a displacement criterion in each iteration. Analyses based on 

displacement convergence criterion only have shown a better performance in terms of 

convergence. But the stresses in elements can be incorrect in this case as some Newton-

Raphson residual forces might remain in the model. Use of contact elements is another key 

reason for convergence problems. Contact elements increase the node and element count in an 
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analysis. Moreover, the contact elements themselves have highly non-linear formulation. In 

comparison, gluing volumes (which merges the coincidental nodes in adjacent volumes) led to 

better convergence performance. However, gluing volumes results in perfect bonding and does 

not provide any provision for a bond-slip response. Thus, the head carries less force in the FE 

model than in the experiment. This is true for both the pullout test and the beam bending test. 

Again, adding springs to simulate bond-slip means adding more nonlinearity to the model. So 

careful and novel approaches are necessary in terms of modeling and meshing so that a 

converged solution can be achieved. 

6.4 Recommendations 

• Using the splitting tensile strength for all concrete specimens in both the pullout model 

and the beam model showed a better agreement in terms of the ultimate pullout force. 

Further studies should be carried out to find which tensile strength is more appropriate 

to use in the finite element modeling of brittle and granular materials. For ductile 

materials, it is intuitive to use the direct tensile and compressive strengths. But for 

materials like concrete, soil etc., it is hard to determine the direct tensile strengths 

reliably. 

• The bond-slip response between steel and concrete can be a significant factor in 

modeling pullout tests and beam bending tests involving headed reinforcing bars. 

• The effect of rib geometry on the bond-slip behavior here were ignored. But from the 

literature review, it is evident that the rib geometry is one of the main factors that affect 

the pullout behavior. There were several bond-slip relationships available from the 

literature that take the effect of bar ribs into account. But the parameters required to use 

those relationships were not available from the experiments in this case. This is an 

important issue for future research. 
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• Observations showed that the brick-shaped element option for SOLID65 produces more 

accurate results and reduces computation time in comparison to the tetrahedral element 

option. However, in the regions of high geometric non-linearity, it is very difficult to 

mesh the volumes with brick-shaped elements. The meshing has to be done carefully 

so that the maximum number of brick elements can be achieved without making the 

model too complicated. Using the brick-shaped meshing option whenever it is possible 

is recommended. 

• FE simulations with same modeling parameters but different symmetry conditions in 

geometry (half model and quarter model) showed no significant variation in results. So, 

it is viable to take advantage of any symmetry in the specimen to reduce computational 

effort. 

• The flexural beam model performs well in the linear region. It also gives more 

conservative results in the nonlinear region. Thus, these results can be reasonably used 

to check against AASHTO Service I and Fatigue I criteria. 

• The flexural beam model should be refined and improved to get more accurate results 

in the nonlinear zone. Modeling the beam FE model for torsional and cyclic loading 

could be another avenue to explore. 

• It is important to bear in mind that, the nonlinearities in the pullout tests and the bending 

tests arise from the cracking of concrete and the failure of the interface, rather than the 

yielding of the steel. In other words, they are true geometric discontinuities. While the 

CZM method used for the interfaces can treat the “delamination” or the cracking as true 

geometric discontinuities, the smeared crack approach used for the concrete cannot. 

Thus, the models developed here are not suitable for the study of load-deflection 

behavior or the development of shear degradation models. 
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Appendix A: Verification of the Concrete Model 

A.1 Introduction 

The first step for modeling the pullout tests was to decide on suitable modeling techniques. It 

was deemed convenient to use the SOLID65 element along with the William-Warnke criterion 

for modeling concrete, because of the element’s cracking capability. The next step was to run 

a simple verification test to see whether the model developed using SOLID65 can produce 

accurate results.  

A.2 Verification Procedure 

For the purpose of concrete model verification, at first a solid concrete block was modeled with 

a 1-inch x 1-inch cross-section and a height of 10 inches. The concrete properties used are 

given in Table A.1: 

Table A.1: Material properties used in the verification model. 

Elastic Modulus 

(psi) 

Poisson’s Ratio Compressive 

Strength (psi) 

Tensile Strength 

(psi) 

6.6 x 106 0.2 12000 835 

 

The SOLID65 element needs two additional parameters namely open shear and closed shear 

transfer coefficients. These two values represent the transfer of shear force between two 

surfaces of a crack in open and closed conditions. The permissible values are from 0 to 1. The 

value of 0 means no shear transfer i.e. a perfectly smooth crack. The shear transfer increases 

with an increasing value meaning rougher crack surfaces. However, previous studies like Ru-

deng 2008 and some preliminary simulations led to the observation that a value smaller than 

0.2 for open shear transfer coefficient can cause convergence issues. That is why the values for 

open and closed shear transfer coefficients used were 0.25 and 0.95 respectively. A value of -

1 was input for uniaxial crushing strength, which turns off the crushing capability in 
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compression. This also helps to reduce the difficulties with convergence. Instead, a bilinear 

elastic-perfectly plastic model was used for compression. However, the tension cracking 

capabilities were turned on. The bottom of the specimen was fixed and tensile and compressive 

loads were applied on the top surface in turns. Then the stress and strain at anode at the middle 

of the specimen were observed. It was found that the model behaved reasonably well in 

compression. The output stress-strain curve almost exactly matched the input for compressive 

stress-strain curve. But with tensile cracks being turned on, it was expected that the stress will 

drop to zero after reaching the tensile strength and stay at that value. But the results showed 

the stress dropped, but did not reach zero, and also, the stress value did not remain stable after 

that point, as shown in Figure A.1. A careful analysis of the results showed that there was a 

stress concentration at the bottom near the support. Concrete at only that region cracked and 

the concrete at the middle did not get a chance to crack. To overcome this issue, another model 

was prepared. The model was 30 inches long with cross sections of 1.5 in x 1.5 in at the top 

and bottom surfaces. The cross sections slowly tapered, and the middle 10 inches became 1 in 

x 1 in. This model could eliminate the stress concentration at the support and force the cracks 

to happen at the middle 10 inches. All other parameters for the analysis stayed the same. Figure 

A.2 shows the crack patterns in the specimen. Each element of SOLID65 can crack in three 

planes and the primary, secondary and tertiary cracks are represented by red, green and blue 

circles respectively. 

The compressive and tensile stress-strain curves are shown in Figures Figure A.3 and Figure 

A.4 respectively. It can be seen that the model performed very well in both compression and 

tension. 
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Figure A.1: Tensile stress-strain diagram of the uniform concrete model. 

 

 

Figure A.2: Crack plot in the tapered concrete model. 
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Figure A.3: Compressive stress-strain diagram for the tapered model. 
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Figure A.4: Tensile stress-strain diagram for the tapered model. 
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Appendix B: Calibration and Verification of Contacts and Bonds 

B.1 Introduction 

As numerous factors affect the pullout behavior of rebars in concrete, establishing a precise 

bond-slip relationship is very difficult without experimental studies on a case-by-case basis. 

However, attempts have been made to develop mathematical models to represent the steel-

concrete bond-slip behavior. For example, Shima 1986 proposed the following bond-slip 

relationship for long embedment length (more than 25 times the bar diameter): 

 

 

Where, 𝜏𝑏 = bond shear stress (psi), 𝑓′𝑐 = concrete compressive strength (psi), 𝑆 = slip (in.), 

and 𝑑𝑠 = bar diameter (in.). In this chapter, the bond-slip model will be verified using this 

equation. 

B.2 Steel-Concrete Bond-Slip Model Verification 

For the verification of the bond-slip model, the experimental data from the studies conducted 

by Rao et al. 2007 was used. To define the stiffness of the spring elements that were used to 

model the interface between the rebar and the concrete, Eq. (B.1) was used. The verification of 

the bond-slip model consists of two parts: 

1. Verification of Eq. (B.1) proposed by Shima 1986. 

2. Verification of the FE model. 

B.2.1 Verification of Eq. (B.1)  

The equation needs two parameters- the compressive strength of the concrete and the bar 

diameter. Rao et al. 2007 used a 6 in x 6 in x 6 in concrete cube with a compressive strength of 

 𝜏𝑏 =  0.9𝑓′𝑐[1 − 𝑒𝑥𝑝 − 40(𝑆/𝑑𝑠)
0.6] (B.1) 
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5800 psi, and a #5 rebar at the center with 6 inches bond length. Putting 𝑓′𝑐 = 5800 psi, and 

𝑑𝑏 = 0.625 inch in Eq. (B.1), the bond stress versus slip diagram was plotted and compared to 

the experimental results obtained by Rao et al. 2007 in Figure B.1. Note that, the equation 

cannot capture the softening of bond after reaching the peak bond stress. However, this 

limitation was observed to have a negligible effect on the results obtained from the FE models 

of the pullout test and the flexural beam tests. Other than that, the values are in good agreement. 

 

Figure B.1: Verification of the equation by Shima 1986. 

 

B.2.2 Verification of the FE Model 

A quarter-model utilizing the symmetry of the test specimen used by Rao et al. 2007 was 

created, as shown in Figure B.2. 21 spring elements were defined between the rebar and the 

concrete, i.e., 3 spring elements at 1-inch interval along the 6 inches bond length. The bond 
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stress versus slip curve was already obtained using Eq. (B.1). The stress values were multiplied 

by the total bond surface area to get the force values. Finally, the force values were divided by 

21 to get the force versus displacement curve for one spring element. This curve was used to 

define the real constant for the COMBIN39 element. The force versus displacement curve used 

for each spring element is shown in Figure B.3. 

 

Figure B.2: Quarter FE model of the pullout test by Rao et al. 2007. 
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Figure B.3: Force-Displacement relation used for each spring element. 

 

Two top edges that were not part of the two planes of symmetry were fixed, and a ramped 

displacement of 1.5 inches upward was applied on the top of the bar. Displacements of two 

nodes, one belonging to the rebar at the top of the embedment, and another belonging to the 

concrete at the same location were monitored. The difference between the two displacements 

gave the slip value. The total reaction at the fixed support represented the pullout force. This 

force values were used to calculate the bond shear stresses. In Figure 2.11, the stress versus 

slip values obtained from the FE model were compared against the values from Eq. (B.1) and 

experimental values obtained by Rao et al. 2007. Observe that, although the response from the 

FE model is a little “softer”, it is still in agreement with the experimental data to an agreeable 

level. Thus, it can be inferred that this modeling technique can be effectively used in the models 

of the pullout test and the beam bending tests. Furthermore, as no “softening” was defined in 
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the real constant for the COMBIN39 element, the FE model curve also becomes horizontal 

after reaching the peak bond stress. However, a slight downward trend can be observed. This 

is possibly due to the failure of the concrete elements attached to the springs. 

 

Figure B.4: Verification of the pullout FE model. 

 

B.3 Concrete- Concrete Interface Model Calibration 

A full-scale FE model was created based on the experiments done by Casanova 2018 to 

determine the modulus of rupture of the precast-closure interface. The model was a rectangular 

beam of 18 inches length and a cross section of 6 inches x 6 inches. The beam was composed 

of two 9-inch sections- one made of the closure pour material, and the other one made of the 

precast concrete. The beam was subjected to a 4-point bending test. The schematic of the test 

is given in Figure 2.15.  
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Boundary conditions similar to the experiments were applied to the FE model. The load was 

applied as displacements. For the material properties, the concrete portions were modeled as 

linear elastic materials. From the experiments, it was evident that the specimens fail at the 

interface only. No cracks were observed in the concrete matrix. So, in the FE model, only 

defining the elastic properties should suffice. Separation- Distance based CZM material was 

defined for the interface. From the experiments, the average modulus of rupture for the 

interface was found to be 612 psi. From Eqs. (4.1) and (4.2), the splitting tensile strength can 

be calculated as 438 psi. Now, Mode I CZM was used, that debonds only due to normal stress. 

For this mode, three inputs are required- maximum normal stress, contact gap at the completion 

of debonding, and artificial damping coefficient. Artificial damping coefficient has the unit of 

time and should be smaller than the smallest step size defined in the analysis. In this analysis, 

a minimum step size of 0.0001 s was used. The damping coefficient was defined as 0.00001 s. 

Now, the total force required for delamination is a function of the other two parameters. Here, 

keeping the maximum normal stress constant at 438 psi, the ultimate force found from the FE 

model for different values of the contact gap are plotted in Figure B.5. 
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Figure B.5: Maximum load versus contact gap for interface model calibration. 

 

From the experiments, the average ultimate force was found to be 7500 lb. In Figure B.5, the 

force 7500 lb corresponds to the contact gap of 0.003 inch. Therefore, this value was used for 

CZM materials in the FE models of the pullout test and the flexural beam test.  
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Appendix C: 3D Modeling of the Flexural Beam Test 

C.1 Introduction 

The finite element analysis should be simplified by using truss or beam elements, taking 

advantage of plane stress/ plane strain conditions, symmetry and axi-symmetry whenever 

possible. But sometimes, 3D models are absolutely required due to the nature of the projects. 

Most commercial FE programs come with their native CAD tools for modeling. For example, 

ANSYS has two CAD modelers- SpaceClaim and DesignModeler. Other than that, many 

exclusive CAD software are also available. However, generally dedicated CAD programs and 

FE programs treat the geometries in a slightly different fashion. That is why the best approach 

is to use the native CAD program included in the FEA distribution. But sometimes, these native 

CAD programs are not very suitable for large and complex models. In that scenario, using an 

external CAD software can make the workflow easier. A 3D model created in a dedicated CAD 

software must be simplified and optimized before using in an FEA program. The commercial 

CAD packages can be broadly divided into two types- direct, and parametric modelers. 

Between them, the parametric type is more suitable for FE analysis. Solidworks, Autodesk 

Inventor, Siemens NX, Creo, and CATIA are some of the most widely used parametric CAD 

programs used in the industry. In this chapter, 3D model of the flexural beam tests will be 

created using Onshape. Onshape is a powerful browser-based parametric CAD tool that has an 

interface similar to that of Solidworks.  

C.2 Step-by-Step 3D Modeling 

Step 1. Go to the Onshape website (http://cad.onshape.com), create an account, and 

sign in. In the dashboard, click on the blue “Create” button at the top left corner (under 

the Onshape logo) and select “Document”. In the dialogue box, type a convenient name 

for the model and then click OK. 

http://cad.onshape.com/
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Step 2. At this point, the workspace will open. Click on the button with three horizontal 

stripes at the top left corner, besides the Onshape logo, and click on “Workspace units”. 

Change the units to inches. 

 

Figure C.1: Changing the units in Onshape. 

 

Step 3. From the top toolbar, click on “Sketch”. A sketch dialogue box should appear 

beside the Feature Tree. In the dialogue box, while the “sketch plane” is selected (in 

blue), select a plane from the Feature Tree. Alternatively, a plane can also be selected 

by clicking that plane in the viewport. For this case, the “Right plane” (YZ plane) will 

be selected. The View Cube at the top right corner of the viewport can be used to adjust 

the view. Clicking on any face or corner of the View Cube will orient the view 

perpendicular to that plane or corner. 
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Figure C.2: Creating a new sketch and adjusting the view. 

 

Step 4. Click on the “Corner rectangle” tool from the top toolbar and draw an arbitrary 

rectangle as shown in Figure C.3. The dimensions are not required to be accurate at this 

point.  

 

Figure C.3: Drawing a rectangle in sketch mode. 

 

Step 5. Click the “Symmetric” button from the top toolbar. Then click the Y-axis in the 

viewport, and the two sides parallel to the Y axis subsequently. Do the same for the 

sides parallel to the Z axis. This will ensure that the dimensions of the rectangle will 

View Cube 
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always be symmetrical with respect to the two axes, and the parallel sides will be 

equidistant from the origin. 

 

Figure C.4: Defining the symmetry constraint. 

 

Step 6. From the top toolbar, select the “dimension” tool. Click on any of the sides of 

the rectangle and type the dimension for that side. Do the same for any of the two sides 

perpendicular to the previous side. In this case, we are using a length of 72 inches, and 

a height of 8 inches. Note that, “over constraining” the sketch will turn the color of the 

sketch to red, and further operations like rotation or extrude might not be possible on 

that sketch. Recurring dimensions can cause “over constrain”. For example, by 

definition, defining the dimension of one side of a rectangle fixes the length of the 

opposite side. Adding another dimension to that opposite side will “over constrain” the 

sketch. 

Step 7. After defining the dimension, click on the green tick mark in the Sketch 1 

dialogue box. This will finalize the sketch and exit the sketch mode. 
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Figure C.5: Defining dimensions. 

 

Step 8. From the top toolbar, click the “Extrude” option. In the appearing extrude 

dialogue box, click on “Faces or sketch region to extrude” and then click on the sketch 

created in the previous steps. Make sure that the “Solid” and the “New” tabs are 

selected. For “End Type”, select “Symmetric” and set the “Depth” to 12 inches. Change 

the view to perspective using the view cube for better visualization. Click the green tick 

mark in the extrude dialogue box to complete the extrusion process. 
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Figure C.6: Extruding a sketch. 

 

Step 9. Note that, in the left-hand side, a new part “Part 1” has been added under the 

“Parts” tree. This is the solid element created in the previous step, which will be used 

to model the precast sections eventually. Right click on the name of the part and then 

rename it using the “Rename…” option. For convenience, here it will be named as 

“Precast”. Now, right click on “Precast” again, and select “Hide…”. The solid object 

will be hidden. This was done to clean up the workspace for drawing a new sketch for 

the closure pour section. 

Step 10. Same as step 3, create another instance of a sketch in the right plane. Change 

the view necessarily from the view cube. Now, using the “Line” tool from the top 

toolbar, draw a shape similar to the one shown in Figure C.7 (the dimensions are not 

needed to be accurate at this point). Now, apply the necessary symmetry constraints 

and dimensions to the sketch as shown in Figure C.8. (Note: the angular dimension is 
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defined by selecting the dimension tool and then clicking the two lines forming the 

angle). 

 

 

Figure C.7: Sketch for the closure pour section. 

 

 

Figure C.8: Adding dimensions and constraints to the sketch. 
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Step 11. Following the procedure described in step 8, extrude this new sketch 

symmetrically with a depth of 12 inches. Rename the new part as “Closure”. Unhide 

the “Precast” part. 

Step 12. Note that, the two parts are now overlapping. One way to solve this issue is to 

use the Boolean function. From the top toolbar, click the “Boolean” tool. In the Boolean 

dialogue box, select Subtract. Then click on “Tool” and then select “Closure” for the 

Parts list. Then click on “Target” and select “Precast”. The tool is the body that is 

subtracted from the target body. Make sure that, the checkbox beside “Keep tools” is 

selected. Then click the green tick mark. The Boolean operation should now be 

complete. Hide the “Closure” part to make sure that the operation was completed as 

intended. Note that, the “Precast” part is no more a continuous body, rather it has been 

turned into two discrete bodies. That is why two “Precast” parts under the Parts list 

appear. Rename the two parts to distinguish them. Here, they will be renamed as 

“Precast 1” and “Precast 2”. 

 

 

Figure C.9: Boolean subtraction operation on the precast body. 

 



103 

 

 

Figure C.10: Result of Boolean subtraction. 

 

Step 13. Hide all the parts. Create a new sketch in “Top plane” For the headed rebar, 

draw a sketch similar to Figure C.11 and give the necessary dimensions as shown in the 

figure. Draw another sketch for the second headed rebar and give necessary dimensions 

as given in Figure C.12. 

 

 

Figure C.11: Sketch for the first headed rebar. 
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Figure C.12: Sketch for the second headed rebar. 

 

Step 14. Exit from the sketch mode. From the top toolbar, select “Revolve”. In the 

dialogue box, make sure that “Solid” and “New” tabs are selected. Click on “Faces or 

sketch regions to revolve” and then select one of the sketches created for the bottom 

rebars. Then click on “Revolve axis” and select the longest axis line of that sketch (the 

line that has a dimension of 40 inches). Make sure that, the revolve type is “Full”. 

Confirm the action. A rebar part will be created. Rename it to “Bottom Bar 1”. Repeat 

the process for the other sketch and rename the new solid as “Bottom Bar 2”. 
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Figure C.13: Revolving the sketch to create rebars. 

 

Step 15. Now, select the “Transform” tool from the top toolbox. For “Entities to 

transform or copy”, select the two headed rebar bodies. For transform type, select 

“Translate by XYZ”. Here, we need to create one more copy for each of the headed 

bars, and the copies should be on the left side of the existing ones, i.e., along the 

negative X direction. So, check the box beside “Copy parts” and put a value of -6 for 

X-axis. Then confirm the operation. Rename the two new parts. 
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Figure C.14: Using the "transform" tool to create copies. 

 

Step 16. Now, repeat the “Transform” operation once more. This time, select all 4 rebars, 

do not check the “Copy parts” box, and put a value of -2 for Z-axis while X and Y 

values remain 0. This operation will bring all four bottom rebars down by 2 inches. 

Step 17. Repeat steps 13 to 16 again for the top bars. Note that, the top bars are not 

headed bars. So for the sketch of a top bar, a simple rectangle will suffice. And finally, 

after creating all four top bar models, translate them by 2 inches in the positive Z 

direction. Make all eight bars visible. They should look like Figure C.15. 
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Figure C.15: All eight rebars after "revolve" and "transform" operations. 

 

Step 18. Finally, as the concrete and the rebar models are now overlapping, a final 

Boolean operation is required. This time, use the eight rebar parts as tools, and the three 

concrete parts as the targets. Make sure to check the “Keep tools” option. Hide the bars 

to make sure the shafts have been created from the Boolean subtraction operation. At 

this point, the model is complete and should look like the one shown in Figure C.16. 

 

 

Figure C.16: Subtracting the rebars from the concrete bodies. 

 



108 

 

Step 19. Now, the 3D model has to be downloaded. Note that, there are two tabs at the 

bottom of the workspace, namely “Part Studio 1” and “Assembly 1”. Right-click on 

“Part Studio1”, then click “Export…”. In the dialogue box, give the 3D model file a 

suitable name. For the “Format”, select a format that is also supported in ANSYS. 

Onshape allows exporting the 3D model in many formats. Among them, PARASOLID, 

ACIS, STEP, and IGES formats are also supported by ANSYS. In this study, it was 

found that the ACIS format provided the most seamless and reliable interchange of 3D 

models between Onshape and ANSYS. Finally, select OK. The 3D model file will begin 

downloading within a few seconds. The downloaded file will have the *.sat extension. 

 

 

Figure C.17: Exporting and downloading the 3D model. 
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Appendix D: Step-by-Step FE Modeling of the Flexural Beam Tests 

D.1 Introduction 

ANSYS APDL is the legacy module of the software that houses all the codes for the 

preprocessing, solution, and post-processing units of the program. ANSYS Workbench is a 

relatively modern interface, which is built on top of the traditional APDL. With a nice 

Graphical User Interface (GUI), the Workbench is generally more intuitive and easier to work 

with. It also allows the user to combine and connect multiple modules like static and dynamic 

structural analysis, modal analysis, electromagnetic analysis, and fluid mechanics. The 

Workbench uses the APDL solver module to analyze the FE model. On the other hand, ANSYS 

APDL is mostly command based, with some basic GUI features available. Being command 

based, although it required more advanced skills on the user’s part, it is more customizable and 

powerful when some advanced and complex FE techniques are involved. In the FE modeling 

of the large beams, both Workbench and APDL will be used to utilize the advantages of both 

the interfaces. 

D.2 FE Modeling of the Three-Point Test 

Step 1. Open ANSYS Workbench. From the toolbox panel on the left, drag one “static 

structural” module to the blank white space in “project schematics”. 
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Figure D.1: Creating a new module in ANSYS Workbench. 

 

Step 2. Double-click on “Engineering Data”. Click on “click here to add new material” 

to type the names of materials to be defined. 

 

Figure D.2: Defining material properties in "Engineering data". 
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Step 3. For concrete material, double click on “Linear Elastic> Isotropic Elasticity” 

from the toolbox panel on the left. Define the elastic modulus and Poisson’s ratio. The 

units can be changed from the drop-down boxes on the right. 

Step 4. For steel material, define isotropic elastic properties. Then double click on 

“Plasticity> Bilinear Isotropic Hardening”. Define the yield strength and tangent 

modulus. 

Step 5. For the interface model, go to “Cohesive Zone> Separation-Distance Based 

Debonding”. For the “Debonding Interface Property”, select Mode I. Then define 

maximum contact stress, contact gap at debonding and artificial damping coefficient. 

Step 6. Close engineering data. Right click on “Geometry” in the static structural 

module. From the context menu, go to “Import geometry> Browse”. Browse to the 

location of the required geometry file, select it and click OK. 

 

Figure D.3: Importing a geometry into ANSYS. 

 

Step 7. Right click on Geometry again, then click on “Edit in DesignModeler”. When 

Design Modeler opens, click on “Generate”. The 3D model should be visible. 
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Figure D.4: Opening geometry using DesignModeler. 

 

Step 8. Make sure that the units are in inches. From the top menu, select “Unit>Inch”. 

In the “Tree Outline”, click the “+” sign beside “X parts, X bodies” (X representing the 

number of parts and bodies in the 3D model). The list of parts and bodies will expand. 

Right clicking on the name of any part or body will open a context menu. From the 

“rename” option, rename the bodies for convenience. 

 

Figure D.5: Renaming the parts in a geometry file. 

 



113 

 

Step 9. With body selection filter selected, click on the two precast concrete bodies 

while holding the control button of the keyboard. Both will be selected and appear 

green. Right-click and select “hide bodies”. Now, only the closure and the rebars should 

be visible. 

 

Figure D.6: Hiding bodies in DesignModeler. 

Step 10. Go to “Create> Slice”. In the “details view” on the bottom left, select “slice by 

surface” for Slice Type. Then click on “Target Face”. Activate face selection filter. 

Click the two vertical faces at the bottom of the closure where the bottom rebars are 

protruding out from. For “Slice Target”, select “Selected Bodies”. Click on “Bodies”, 

and select the four bottom rebars, click “Apply”. Click “Generate”. Now, each bottom 

rebar will be sliced into two divisions. 
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Figure D.7: Slicing the bottom rebars. 

 

Step 11. Now hide everything except the bottom rebars. Zoom in on them. Notice that, 

there are two lines running along the entire length of one rebar (including the head). 

The lines are either on the top and bottom of the bar or on the sides. Go to “Concept> 

Split Edges”. In the details view, for split type, select “Split by N”. Click on “Edges”. 

Now select the edges along the front parts of the bottom rebars (the parts inside the 

closure, excluding the heads). Click apply. 8 edges should be selected. Enter 8 for the 

value of FD4, N. Keep the values of FD2 and FD3 at 0. Then click “Generate”. The 

edges should be divided into 8 parts each. 

 

Figure D.8: Splitting the edges by number of divisions. 
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Step 12. Do the same as the previous step for the edges on the parts of bottom bars that 

are inside the precast sections. Except for this time, put 31 for FD4.  

Step 13. Right-click anywhere on the graphics window and select “Show all bodies”. 

Now, select the closure portion, right click and select “Hide all other bodies”. 

Everything except the selected body will be invisible. Now rotate, pan and zoom to 

inspect the four shafts in the closure that the bottom rebars run through. There are two 

similar lines for each shaft. Split all eight of them using the method described in steps 

10 and 11. Do the same for the shafts in the precast sections, but with FD4= 31. 

 

Figure D.9: Only the closure pour body and the shafts for the rebars in it are shown. 

 

Step 14. Click on “Tools> Face Split”. In the details view, make sure that the split type 

is “by plane”. Click on “Target Face”. Select the face at the top of the closure pour. 

Click “Apply”. Click on “Tool geometry”. Now go to the Tree Outline and select the 

plane that runs perpendicular to the selected face along its width (in this case, the ZX 

plane). Then click “Apply”. The edge that is now splitting the face, will be used later 

to apply the load in three-point bending.  
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Figure D.10: Splitting a face by a plane. 

 

Step 15. Click the “+” besides “X parts, Y bodies” again. Select the 8 bodies for the 

bottom rebars, while holding down the control key. Right-click and select “Form new 

part”. Rename the part to convenience. This will treat all the parts of the bottom rebars 

as a monolith and during meshing, ANSYS will treat all of them as one object. Thus, 

the meshes will have merged nodes between the two parts of each bar, eliminating the 

need for defining contact elements between them.  
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Figure D.11: Combining multiple parts into one part. 

 

Step 16. Close Design Modeler. Double-click on “Model” to open ANSYS Mechanical. 

After Mechanical attaches the geometry, go to “Units” and select “U.S. Customary (in, 

lbm, lbf….)”. 

Step 17. In the outline window on the left, expand the “Geometry” section. Click on each 

of the part names. In the details window at the bottom left, click on “Assignment” under 

“Material” section, click on the arrow next to it, and select the corresponding material 

defined in steps 3, 4 and 5. 
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Figure D.12: Assigning materials to bodies. 

 

Step 18. Right click on the name of the closure pour body. Then go to “Insert> 

Commands”. In the command window, write the code for closure pour concrete 

material given at the end of this appendix. Do the same for the precast bodies. 
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Figure D.13: Defining material properties using the APDL command module. 

 

Step 19. Expand the “Connections> Contacts” tree. ANSYS will detect all the contact 

surfaces automatically and assign a bonded connection type by default. In the details 

window, change the contact details according to the following table: 

Table D.1: Contact types and formulations. 

Contact Between Type Formulation 

Closure pour and precast Bonded Augmented-Lagrange 

Top rebar and concrete Bonded  MPC 

Bottom rebar and concrete No separation MPC 

 

The Cohesive Zone Model (CZM) only works with bonded contacts with Augmented-

Lagrange or Pure Penalty formulation. Other than that, the use of MPC formulation is 

helpful to reduce the nonlinearity in the model. MPC stands for multi-point constraint 

and it employs constraint equations to define the relationships between contact and 

target elements. 
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Figure D.14: Defining the contact types and formulations. 

 

Step 20. In the outline tree, right click on “mesh” then go to “Insert> Method”. In the 

details of the method, make sure that the Scoping Method is “Geometry Selection”. 

Then click on “Geometry” in the details window and with body selection filter 

activated, select the three concrete bodies and then click “Apply” in the details window. 

For “Method”, select “Tetrahedron” and for “Element order”, select “Linear”. This step 

is necessary because SOLID65 is a linear element with brick or tetrahedral shape. As 

the bodies are not “sweepable”, the only option is to use tetrahedrons. If the elements 

are not linear or tetrahedral, ANSYS will not use SOLID65 elements ignoring the 

commands entered earlier. Right clicking on “Mesh” and then going to “Show> 

Sweepable bodies” will show the bodies that can be swept to create brick elements. 
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Figure D.15: Assigning mesh sizes and types to bodies. 

 

Step 21. Right click on “Mesh” and click “Generate Mesh”. ANSYS will create mesh 

automatically. If the meshes seem too coarse, go to the details window, under 

“Defaults”, set the value of relevance to 10. Then under “sizing”, set the values of 

“relevance center” and “span angle center” to medium or fine until desired mesh size is 

achieved. A custom element size can also be defined from “Element Size” option under 

“Sizing”. But if the defined size is not conforming with the geometry or the changes to 

the geometry (face or edge split), the meshing could fail. 

Step 22. Go to the top of the outline tree and right-click on “Model (A4)”. Go to “Insert> 

Fracture”. A new item called “Fracture” will be added in the tree under “Mesh”.  

Step 23. Right click on “Fracture” and go to “Insert> Contact debonding”. A contact 

debonding sub-item will appear under the “Fracture” tree item. Select it and make sure 

that, in the details window, the method is CZM. For “Material”, select the CZM 

material defined earlier. The drop-down menu beside “Contact region” will show the 

list of all defined contacts. Select one of the two contacts between the precast and 

closure sections. Repeat this step for the second contact region. 
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Figure D.16: Defining contact regions using CZM. 

 

Step 24. In the outline tree, click on “Static Structural (A5)” and then activate the edge 

selection filter. The bottom edges of the right and left faces of the model will be used 

to define supports. Select the edge on the left, right click on “Static Structural” and then 

click “Insert> Fixed support”. Select the right edge, right click on “Static Structural”, 

go to “Insert> Displacement”. In the details window of the Displacement support, enter 

0 for the value of “Z Component”.  

 

Figure D.17: Adding supports to the model. 
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Step 25. Select the edge in the middle of the top face of the closure, right click on “Static 

Structural”, select “Insert> Displacement” and in the details window, enter “-0.25” for 

the value of “Z Component”.  

 

Figure D.18: Assigning displacement-based loading to the model. 

 

Step 26. Now, with the “Static Structural” tree item selected, go to the top menu bar and 

select “Tools> Write Input File”. In the save window, select the desired location for the 

input file to be saved and give it a suitable name. 

Step 27. Close ANSYS Workbench. Make sure the Workbench project is saved. This 

project will be used later to retrieve the results. Open ANSYS Mechanical APDL. 

Define a location and a jobname for the APDL project. Click “File> Read input from…” 

and select the input file created in the previous step. Click OK. Then go to “Plot> 

Elements”. The meshed model will appear. 
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Figure D.19: Importing the input file into APDL. 

 

Step 28. Go to “Preprocessor> Element Type> Add/Edit/Delete”. In the Element Type 

window, click Add. Now, select the COMBIN39 element and click OK. In the Element 

Type window, select the COMBIN39 element just added and click “Options…”. In the 

options window, select UY for the value of K3. This makes sure that the springs have 

1 degree of freedom along the Y-axis. Also, take note of the element type number for 

the COMBIN39 element. Close the element type window. 

Step 29. Go to “Preprocessor> Real Constants>Add/Edit/Delete”. In the appearing 

window, click on Add. In the element type selection window, select the COMBIN39 

element and click OK. A real constant definition window will appear. For convenience, 

make sure that the real constant set number is the same as the element type number for 

COMBIN39. No need to define the real constants right now. Click OK and close the 

Real Constants window. 

Step 30. Go to “Modeling> Create> Elements> Elem Attributes”. In the attribute 

window, select the element type number and the real constant set number for 
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COMBIN39 for the values of “[TYPE]” and “[REAL]”. Click OK and close the 

window. 

 

Figure D.20: Defining the attributes for the new elements to be created. 

 

Step 31. Go to “Modeling> Create> Elements> Auto Numbered> At Coincid Nd”. Keep 

the tolerance value at default and click OK. In the node selection dialogue box, click 

“Pick All”.  
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Step 32. Click “Select> Entities”. In the selection window, for the first two items, select 

“Elements” and “By attribute”. Then select the radio button beside “Elem type num”. 

Then in the input box, enter the element type number for COMBIN39. Click “Apply” 

then “Plot”. The spring elements will be displayed. If there are not enough spring 

elements around the bottom bars, go to “Modeling> Delete> Elements” and from the 

dialogue box, select selection type as box. Select all spring elements by dragging a box 

and click OK. Then repeat step 31 but selecting a larger number for the tolerance value. 

Repeat the process until a satisfactory number of springs can be seen around the bottom 

bars. 

 

Figure D.21: Viewing only the spring elements. 

 

Step 33. Now, select the spring elements by element type number again, but after hitting 

Apply, do not click plot. Then go to the Mechanical APDL Output Window. It should 

show the number of elements selected. Dividing the total number by 4 to get an average 

number of springs per rebar. Use this number to calculate the force vs. displacement 

curve for each element. Update the real constant for COMBIN39 elements. 
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Figure D.22: Number of elements selected shown in the APDL output window. 

 

Step 34. Go to “Solution>Analysis Type>Sol’n Controls” and set the parameters 

according to the following three figures. 
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Figure D.23: Settings for the analysis. 

 

Step 35. Click “Solution>Solve>Current LS”. Click OK if any dialogue box appears. 

The solution process will start. 

Step 36. After the solution process in APDL is over, save and close APDL. Open the 

Workbench project file created earlier and open “Model”. 

Step 37. With “Solution” selected in the outline tree, go to “Tools>Read Results File” 

and select the result file produced by APDL. The file should be in the folder where the 

APDL project was created and will have a name of “filename.rst”, where “filename” is 

the jobname defined at the start of the APDL model. 

Step 38. The results file should take a few minutes to load. After it is loaded, all the 

results can be obtained using the Workbench project as if it were a Workbench model. 
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D.3 Step by Step Modeling of Four-Point Bending Tests 

 

Step 1. Follow steps 1 to 13 for the modeling of three-point bending. At step 14, hide 

the two precast bodies. Click on the “New Plane” icon at the top-left corner. In the 

details window, select “From face” as type. Select the top-right face of the closure pour 

body as “Base face”. For “Transform 1 (RMB)”, select “Offset Global Y”. For “FD1”, 

put a value of 7 inches. Click Generate. A new plane will be generated. 

 

 

Figure D.24: Defining a new plane from a face. 

 

Step 2. Do the same for the other side. This time, FD1 should be -7 inches. Now, there 

are 2 newly created planes. Now using the “Face Split” option, split the two top faces 
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of the two closure pour sections with the help of the two newly created planes. These 

two edges will be used to define the loads in step 25. 

Step 3. Follow steps 15 to 38 for modeling of three-point bending tests. 

 

D.4 APDL Code for Defining Closure Pour Material Properties 

/PREP7   
!*   
ET,MATID,65  
!*   
KEYOPT, MATID,1,0 
KEYOPT, MATID,3,0 
KEYOPT, MATID,5,0 
KEYOPT, MATID,6,0 
KEYOPT, MATID,7,1 
KEYOPT, MATID,8,1 
!*   
!*   
MPTEMP,,,,,,,,   
MPTEMP, MATID,0   
MPDATA,EX, MATID,,4.4e6   
MPDATA,PRXY, MATID,,0.19  
TB,MISO, MATID,1,3,0  
TBTEMP,0 
TBPT,,3380/4.4E6,3380    
TBPT,,0.0025,8450    
TBPT,,0.003,8450 
TB,CONC, MATID,1,9,   
TBTEMP,0 
TBDATA,,0.15,0.95,768,-1,,   
TBDATA,,,,0.5,,, 

D.5 APDL Code for Defining Precast Material Properties 

/PREP7   
!*   
ET,MATID,65  
!*   
KEYOPT, MATID,1,0 
KEYOPT, MATID,3,0 
KEYOPT, MATID,5,0 
KEYOPT, MATID,6,0 
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KEYOPT, MATID,7,1 
KEYOPT, MATID,8,1 
!*   
!*   
MPTEMP,,,,,,,,   
MPTEMP, MATID,0   
MPDATA,EX, MATID,,3.3E6   
MPDATA,PRXY, MATID,,0.17  
TB,MISO, MATID,1,3,0  
TBTEMP,0 
TBPT,,2100/4.4E6,2100    
TBPT,,0.0025,5250   
TBPT,,0.003,5250 
TB,CONC, MATID,1,9,   
TBTEMP,0 
TBDATA,,0.15,0.95,614,-1,,   
TBDATA,,,,0.5,,, 

 

 


